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CHAPTER 1

Introduction

PhysioZoo is a collaborative platform dedicated to the study of the heart rate variability (HRV) from Humans and
other mammals’ electrophysiological recordings. The main components of the platform are:

* Software

— An open-source algorithmic toolbox for matlab (mhrv), which implements all standard HRV analysis
algorithms, a selection of peak detection algorithms and prefiltering routines. This can be used within your
own data analysis code using the mhrv APL

— An open-source graphical user interface (PZ—-UTI) that provides a user friendly interface for advanced HRV
analysis of RR-intervals time series and data visualization tools. This enables easy access to HRV analysis
without writing any code.

e Databases

— A set of annotated databases (P Z—DB) of electrophysiological signals from different mammals (dog, rabbit
and mouse). Available here.

— Manually audited peak locations and signal quality annotations for each of the recordings.
* Configuration

— A set of configuration files that adapt the HRV measures and mhrv algorithms to work with data from
different mammals.

— All HRV measures can be further adapted for the analysis of other mammals by creating simple human-
readable mammal-specific configuration files.

Note: The PZ-UTI user interface has two modules: a Peak detection (used to process electrophysiological
signals and obtain the RR time series) module and a HRV analysis module (used to process the RR time series
and compute HRV measures).

The PhysioZoo mission is to standardize and enable the reproducibility of HRV analysis in mammals’ electrophysio-
logical data. This is achieved through its open source code, freely available user interface and open access databases.
It also aims to encourage the scientific community to contribute their electrophysiological databases and novel HRV
algorithms/analysis tools for advancing the research in the field.
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Feedback on how to improve the PhysioZoo platform is welcomed. Do not hesitate to drop us an email at:
physiozoolab@ gmail.com

Source code, data or interface enhancement contributions are welcome. Look here on how to contribute to PhysioZoo.
Please include the standard citation to PhysioZoo when using the resources available on the platform:

Joachim A. Behar*, Aviv A. Rosenberg*, Ido Weiser-Bitoun, Ori Shemla, Alexandra Alexandrovich,
Evgene Konyukhov, Yael Yaniv. 2018. ‘PhysioZoo: a novel open access platform for heart rate variability
analysis of mammalian electrocardiographic data.” Accepted for publication in Frontiers in Physiology.

*Equal contribution.

1.1 Installing PhysioZoo

The PhysioZoo user interface (PZ—-UTI) can be run from Matlab or be installed as a standalone application. If you do
not need the graphic user interface then you can directly download the HRV source code (mhrv library). PZ-UT and
mhrv were tested for Matlab 2016a and above running on Windows.

1.1.1 PhysioZoo mhrv matlab toolbox

The PhysioZoo platform includes the mhrv matlab toolbox which implements all the algorithmic functions required
by PhysioZoo (and more). The toolbox is aimed at researchers or developers that wish to write their own code for
ECG signal processing, HRV analysis or other applications by using the mhrv toolbox as a library.

See the toolbox’s Getting Started page for installation and initial setup instructions. The API reference for the toolbox
is available on this site.

The development version of the mhrv toolbox is available here.

1.1.2 PhysioZoo Pz-UI user interface

The PhysioZoo user interface (PZ—-UT) is aimed mainly at researchers working with physiologic data who do not wish
to write any code for data analysis. It provides many tools out of the box, all accessible from an interactive UL

The UI can be run from Matlab or be installed as a standalone application. PZ-UI was tested for Matlab 2016a and
above running on Windows.

Running Pz-UI from within Matlab

Versions supported: MATLAB 2016a and above.
1. Download or clone the source code from the repository.

2. From MATLAB launch PhysioZoo by running the script PhysioZoo . m from the root of the repo.

Note: The PZ-UTI user interface has two modules: a Peak detection (used to process electrophysiological
signals and obtain the RR time series) module and a HRV analysis module (used to process the RR time series
and compute HRV measures).
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Running Pz-UI as standalone software (.exe)

Operating system: Windows 10 (and above), 64 bits.

After downloading the software from the project’s main page, run the physiozoo.exe file. This will start the
installation process. You can then go through the following steps.

Note: Some of the screens might be slightly different depending on the version of Windows you are using and whether
you already have the MATLAB runtime compiler installed. If Matlab runtime compiler is not installed then it will be
done through this process but the installation might take some time.

1. If you get the following screen displayed then click “Run”

SmartScreen can't be reached right now

2. When the following screen is prompted then click “Next”

1.1. Installing PhysioZoo 3
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%P PhysioZoo Installer - a X

Connection Settings

PhysioZoo 1.0

Heart Rate Variability Analysis from Mammals Electrophysiological Data
Technion BBS Laboratory

physiozoolab@gmail.com

3. When the following screen is prompted then click “Next”

P Required Software - O X

MATLAB Runtime is required.

Choose installation folder: M K [11 A B
s

“A\Program Files\MATLAB\MATLAB Runtime Browse...

R2017a

Restore Default Folder

MATLAB and Simulink are registered trademarks of The MathWorks, Inc. Please see
mathworks.com/trademarks for a list of additional trademarks. Other product or brand names may
be trademarks or registered trademarks of their respective holders.

WARNING: This program is protected by copyright law and international treaties. Copyright
1984-2017, The MathWorks, Inc. Protected by U.S. and other patents. See MathWorks.com/patents

) MathWorks-

4. When the following screen is prompted check the “Yes” and then click “Next”
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P License Agreement — O %
The MathWorks, Inc. g
MATLAB RUNTIME LICENSE

IMPORTANT NOTICE
BY CLICKING THE "YES™ BUTTON BELOW, YOU ACCEPT THE TERMS OF THIS LICENSE. IF YOU ARE NOT WILLING TO DO SO,
SELECT THE "NO" BUTTON AND THE INSTALLATION WILL BE ABORTED.

1. LICENSE GRANT. Subject to the restrictions below, The MathWorks, Inc. ("MathWorks") hereby grants to you, whether
you are an individual or an entity, a license to install and use the MATLAB Runtime (“Runtime”), solely and expressly for the
purpose of running software created with the MATLAB Compiler (the “Application Software"), and for no other purpose.
This license is personal, nonexclusive, and nontransferable.

2. LICENSE RESTRICTIONS. You shall not modify or adapt the Runtime for any reason. You shall not disassemble,
decompile, or reverse engineer the Runtime. You shall not alter or remove any proprietary or other legal notices on or in
copies of the Runtime. Unless used to run Application Software, you shall not rent, lease, or loan the Runtime, time share
the Runtime, provide service bureau use, or use the Runtime for supporting any other party’s use of the Runtime. You shall
not sublicense, sell, or otherwise transfer the Runtime to any third party. You shall not republish any documentation which
_mau he nrovided in connaction with the Runtime Al rinhts not aranted _includina withaot limitation rinhts to renradoce

Do you accept the terms of the license agreement? @E (JNo

) MatkWorks

5. When the following screen is prompted then click “Install”

P Confirmation _ O %

PhysioZoo will be installed in:
CA\Program Files\Technion\PhysioZoo

PhysioZoo requires MATLAB Runtime R2017a.

MATLAB Runtime R2017a is already installed in:
CAPregram Files\MATLAB\MATLAB Runtime\v92

intal >

6. The installation will start. Wait until it is finished. Note that this might take quite some time.

1.1. Installing PhysioZoo 5
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P 45% Complete - O *

Performing post-installation tasks. This may take a few moments...

I %

Cancel

7. When the installation is finished it will show the following screen.

%P Installation Complete = a X

Installation completed successfully.

You can now click on the PhysioZoo logo located on your desktop or in the list of programs.
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1.2 Electrocardiographic recordings

Electrophysiological signals need to be digitized before they can be worked with. For that purpose both the range and
domain need to be digitized. Important attention should be given to the sampling frequency and quantization level in
order to ensure the integrity of the data and a meaningful HRV analysis.

1.2.1 Sampling frequency and quantization level

Sampling refers to the process of discretizing the time domain. The sampled time domain will be described by the
sampling frequency (fs) corresponding to the number of samples per second. The resulting digital signal will have a
discrete time domain.

Quantization refers to the process of constraining an input from a continuous signal to a discrete set of values. The
resulting digital signal will have a discrete range.

The sampling frequency and the quantization that are used for recording data will affect the quality of the HRV
analysis and thus it is important to inspect the raw data that are being recorded and eventually, when necessary, adjust
the sampling frequency and quantization level of the recording device.

1.2.2 Examples of typical issues

The following example shows what happens when a mouse ECG recording is downsampled from 1000 Hz to 500 Hz
and 250 Hz, thus simulating the type of signal you would record if your original sampling rate was below 1000 Hz.
As you will observe, the exact peak location is significantly affected by the sampling frequency. It is degraded at 500
Hz and at 250 Hz it will be very poor. Thus for mouse data, 1000 Hz is really the minimal sampling frequency to use
in order to ensure a meaningful HRV analysis. However, note that the adequate sampling frequency will be mammal
specific.

1.2. Electrocardiographic recordings 7
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The following example shows a rabbit recording where the quantization level was poorly set. This can be observed
by the low discretization levels / high amplitude ‘jumps’ between consecutive samples. A poor quantization can affect
the HRV analysis (as well as any morphological analysis).
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1.3 Peak detection

In this tutorial you will learn how to load an electrocardiogram (ECG) recording and perform R-peak detection. You
will also learn how to manually correct misdetected peaks. Peak detection is performed in the Peak detection

module.
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1.3.1 Introduction

Accurate peak detection is critical for performing meaningfull HRV analysis. PhysioZoo provides a module to perform
accurate peak detection from different mammalian species and the option to manually correct misdetected peaks to
ensure the accuracy of the RR time series that will be analysed in the HRV analysis module.

1.3.2 Why mammal specific peak detection?

Numerous algorithms for finding R-peaks in human ECGs have been developped. However, these need to be adapted
to the different dynamics accross mammalian species. PhysioZoo provides a set of peak detection algorithms (rgrs,
jars and wjqgrs) with parameters preset for human, dog, rabbit and mouse. Suitable parameters for other mammals
can be specified by the user from the configuration panel.

Representative example of the R-peaks detected (A) using the original ggrs human peak detector and (B) using the
rqgrs PhysioZoo detector with parameters adapted for the different mammals. This figure illustrates the need for
mammal-specific R-peak detectors to ensure a correct evaluation of the RR time series.
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1.3.3 Performing peak detection in PhysioZoo

1. Open the PhysioZoo user interface PZ-UT.
2. Click “Peak Detection” on the Menu bar to open the peak detection interface.

3. Load an ECG recording (e.g. File -> Open File -> Rabbit_example.txt). The ECG will be displayed. The default
R-peak detector (rgrs) will run automatically. You will see some red crosses appearing on the ECG signal at
the locations that have been detected (panel A).

1.3. Peak detection 9
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4. You can browse through the recording by stretching and moving the red window displayed in panel B. You can
also move through the recording by using the arrows circled in red on the right hand side. Finally, you can also
use the mouse scroll wheel and Ctrl scroll wheel.

PhysioZoo_PeakDetection

:rtm;m e o ) P o200-physiz00 1000 646441916063 Examptes TXTvabbiiRaboH_oxample_oca b
mm= B P S AU, NS
o A i “““‘Mlm“'m\mhmlmmuu|nl1nlMllnlulmllﬂlﬂﬂﬂlﬂ"mhnwuﬂﬂmmﬂllﬂlllﬂlmllﬂl e i
il :
ﬁ[ & O:L ‘*‘“*“F " ) M“‘L"’U"MM"%M“WT*

00:00:00 00:08:20 00:16:40 00:25:00

NB PEAKS (n.u)
NB PEAKS ADD (n.u)
NB PEAKS RM (n.u)

PR BAD SQ (%) Percentage of the record annotated as bad quality (i.e. signal quality # 'A’) 0

Warning: The input ECG data imported in PhysioZoo MUST be in mV (i.e. physiological units). The R-peak
detector might not run appropriately if the data are not correctly scaled.

1.3.4 Manual peak correction
Sometimes the R-peak detector might make mistakes and miss some R-peaks/detect some points which are not peaks.
You can fix these mistakes manually using the PhysioZoo interface by using the following functionalities:

1. Select a part of the ECG which is noisy and where some peaks were misdetected.

2. Point your cursor on a misdetected peak or at the location where a peak is missing. When you click, PhysioZoo
will automatically remove/add a peak at this location.

3. If a whole segment contains misdetection and you need to clear all the peaks within this section, draw a rectangle
on the area where you want the peaks to be deleted (see dotted rectangle figure below). When you ‘drop the
rectangle’, all the peaks contained within it will be deleted.

4. Save your R-peak time series: File -> Save Peaks.
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PhysioZoo_PeakDetection - X
File »
Record Configuration Display Ci\Users\Joachim. T-BM-Y Y-L6\D i physi toolbox-8d644191c06 TXT\rabbit\Rabbit_example_ecg.txt | compute |
Record file name: Rabbit_example_ecq.txt - 6~ [“] Auto Com.
Peaks file name: 4r Plot HR
ignal quaity flo name: s 2 [ Reset |
E
Time series length: 0:26:0277 h:min:sec.msec © 0
O
w
Mammal Rabbit = Py
Integration level ECG v 4k
Peak detector rars = I | I I I I |
00:16:45 00:16:50 00:16:55 00:17:00 00:17:05 00:17:10 00:17:15
Annotation Peak v Time (sec)
5 1}
3
=051 u
. ] P N N R— b N X E— ‘,y_MlUw‘*,

0= 1
“ . 00:00:00 00:08:20 00:16:40 00:25:00 gg

Description Values

NB PEAKS (n.u) Total number of peaks 5449
NB PEAKS ADD (nu) Number of peaks manually added by the user 0
NB PEAKS RM (n.u) Number of peaks manually removed by the user o
PR BAD 5Q (%) Percentage of the record annotated as bad quality (i.e. signal quality ='A’) 0

1.3.5 Configuration for other mammals

The PhysioZoo R-peak detectors are readily adapted for human, dog, rabbit and mouse ECG data. If you need to
use them on another species then you will need to adapt their parameters accordingly. The parameters for the peak
detectors can be found under the “Config Params” tab. You can save the configuration of the peak detectors in order
to re-use it by going to File -> Save configuration file.

1.3. Peak detection 11
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Record Configuration Display
rqrs
HR 264 BPM
Qs 0.02 sec
QT 0.12 sec
QRSa 294 uVolts
QRSamin 114 uVolts
RRmin 014 sec
RRmax 0.58 sec
jqrsiwijqrs
Lower cutoff frequency 3 Hz
Upper cutoff frequency 150 Hz
Threshold 0.5 n.u.
Refractory period 0.088 Sec
Window size 10 sec
[v] Auto
Peaks window 40 ms

For rgrs:
* HR: Typical heart rate (beats/min)
* QS: Typical QRS duration (sec)
* QT: Typical QT interval duration (sec)
* QRSa: Typical QRS peak-to-peak amplitude (microVolt)
* QRSamin: Minimum QRS peak-to-peak amplitude (microVolt)
* RRmin: Minimum RR interval (“refractory period”, sec)
¢ RRmax: Maximum RR interval (sec)
For jgrs and wjgrs:
* Lower cutoff frequency: the lower cutoff frequency of the bandpass filter used to prefilter the ECG (Hz)
» Upper cutoff frequency: the upper cutoff frequency of the bandpass filter used to prefilter the ECG (Hz)
* Threshold: the energy threshold (nu)
* Refractory period: the minimal time interval tolerated between two consecutive peaks (sec)

* Window size: this parameter is only used with wjqrs. This peak detector is applied on consecutive (non-
overlapping) windows of size “Window size’ (sec).

Other:
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* Peaks window: when manually correcting peaks, this parameter corresponds to the window size for which to
look for a local maximum / minimum around the click location.

1.3.6 Frequently asked questions

What is a suitable sampling frequency for my data?

In order to locate the peaks accurately from the electrophysiological signal it is important to work with data sampled
at a sufficiantly high frequency. For example, for animal data with a high heart rate such as the mouse ECG, the QRS
is only a few milliseconds long (~ 7 ms). Thus even at a relatively high sampling rate such as 1000 Hz the QRS will
only be described by very few (~7) samples. See this tutorial for a visual example.

What'’s the difference between peak detectors?

Sometime a peak detector will fail to detect the R-peaks. This is due to the fact that these detectors were originally
built for human ECG analysis and extended to work with mammalian data. In animal ECGs the position and type
(e.g. subcutaneous) of the electrodes are not as standardized as for the uman. For that reason we included a set of
three R-peak detectors so that it is possible to change to the one that is performing best for your specific dataset and
electrodes configuration.

How best to deal with long recordings?

If you deal with long recordings (i.e. hours long) then use rgrs or wjgrs.

1.4 Preprocessing

In this tutorial you will learn how to preprocess your RR time series within the HRV analysis module. The
resulting preprocessed time series is traditionally called the ‘NN’ time series.

1.4.1 Introduction
When loading an RR time series in the HRV module, one of the parameters you need to set is the preprocessing
method.

We implemented in PhysioZoo three methods (and one combination of methods) for pre-filtering the RR-interval time
series:

* Range,
* Moving average,
¢ Quotient,

* Combined (the combination of the Range and the Moving average filters).

1.4.2 Why is preprocessing important?

A preprocessing step is usually performed in HRV analysis to filter out suspected ectopic beats, missed beats and
artifacts.

1.4. Preprocessing 13
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The example below shows an ECG segment with some transient noise. Note the miss-detected R-peaks. Leaving these
miss-detected R-peaks could lead to the evaluation of incorrect HRV measures.

10

ECG (mV)
~

—ECG signal
% R-peaks
1

4 | 1 | |
4310 4312 4314 4316 4318 4320

Time (sec)

Below, the corresponding RR interval time series that is filtered. The filtering allows to remove the sudden increase
and decrease in the RR time series that are caused by the miss-detected beats.

1.4
%
4]
L2
0
©
>
| -
3z
j= —RR intervals
o 0.6 Filtered intervals
o 2 Range outliers
o Lowpass outliers
0.4 = Quotient outliers
—window average
---window threshold
02 ! | | | |
4280 4290 4300 4310 4320 4330

Time (sec)
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1.4.3 Preprocessing methods in PhysioZoo

You can select the preprocessing filter with the dropdown “Preprocessing” located under the Main tab. You can vary
the level of preprocessing by using the dropdown “Preprocessing level” located under the Main tab. Three levels of
preprocessing are available: “Weak”, “Moderate” and “Strong”. If you want to customize the preprocessing filters
further then you can access each of the parameters of each filter by going to Options -> Filtering.

The image below shows an example of a rabbit RR time (blue time series) series which has been filtered over the
selected window (green time series) using the Moving average filter.

@ PhysioZoo - X
File  Peak Detection ~
Main Single  Options  Display C:\Users\Joachim.T-BM-YY-L6\D 10200-physioz00-100lbox-8d64419 TXT\rabbi it_example_qrs.txt [ compute |
s e T T T
File name Rabbit_example_grs.txt [ Auto Compute
04 -
Signal quality file name Plot HR
035
Time series length 00:25:59.974  h:min:sec.msec 5 | Reset |
2 031 T . I —
2 iy hi a4y Ll
amnal Rabbit v & WMW‘M# "EM (gl v AL
ro2sT \
Integration level v
ECG 02l
Preprocessin v
P 9 Moving average <: 0.15 - Time series Selected fitered timp series -
Preprocessing level Default v T . ’ - - - -
00:00:00  00:01:40  00:03:20  00:05:00  00:06:40  00:08:20  00:10:00 ~ 00:11:40  00:13:20  00:15:00
Default frequency method \welch ~ Time (h:min:sec)
04fF
035 |
03[, PR YT A Aol
0.25 oy X - T ‘
| ] > |
00:00:00 00:08:20 00:16:40 00:25:00
Statistics Time. Frequency NonLinear
Description Values
AVNN (ms) Average NN interval duration 28130 ~
SDNN (ms) Standard deviation of NN interval duration 1027
RMSSD (ms) The square root of the mean of the sum of the squares of differences between adjacent NN intervals 6.89
ONN1T (%) Percent of NN interval differences greater than 17.0milliseconds 113
SEM (ms) Standard error of the mean NN interval 032
PIP (%) Percentage of inflection points in the NN interval time series 4958
1ALS (nu) Inverse average length of the acceleration/deceleration segments 050
PSS (%) Percentage of short segments 4599
PAS (%) The percentage of NN intervals in alternation segments 2077
B WELCH (nu) Slope of the linear interpolation of the spectrum in a log-log scale for frequencies below the upper bound of the VLF band 070
HF NORM WELCH (%) High frequency power in normalized units: HF/(Total power - VLF)*100 (welch) 41.90
HF PEAK WELCH (Hz) Peak frequency in the high frequency band (welch) 051
HF WELCH (ms™2) Power in the high frequency band (welch) 1495
LF NORM WELCH (%) Low frequency power in normalized units: LF/(Total power - VLF)*100 (welch) 58.10
LF PEAK WELCH (H2) Peak frequency in the low frequency band (welch) 009
LF WELCH (ms™2) Power in the low frequency band (welch) 2073 .

1.4.4 Frequently asked questions
Why preprocessing the RR time series?

Preprocessing methods are useful to remove local miss-labelled beats caused by noise or sudden drop/increase in the
RR time series due to ectopic beats.

What is the limitation of preprocessing routines?

In the presence of large segments of noise it will not help. Rather such large segments of bad quality data should be
discarded from the analysis. You can annotate the quality of the electrophysiological time series in order to have this
contexttual information when performing HRV analysis.

Is there instances when not to preprocess the RR time series?

If your aim is to use HRV measures for identifying certain arrythmic episodes for example then you might want to
avoid preprocessing the RR time series or to use a weak preprocessing in order to only remove outliers beats. Indeed,

in this use case you will want to capture the important irregularities (e.g. atrial fibrillation) in the RR intervals of the
time series.

1.4. Preprocessing 15
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1.5 Heart Rate Variability analysis

In this tutorial you will learn how to compute the Heart Rate Variability (HRV) measures and export the computed
values within the PhysioZoo HRV analysis module. You will learn how to analyse a single window of defined
length and a series of consecutive windows.

1.5.1 Introduction

HRV analysis is particularly interesting because it provides a non-invasive way to monitor cardiac function and the
autonomic system activity. In particular, in the context of animal studies, HRV tools can be used to study the effects
of mutations and pharmacological treatments. PhysioZoo provides the framework and tools for performing HRV
analysis from human and animal model data.

1.5.2 Why mammal specific HRV?

Because the heart rate range, dynamics and autonomic control can vary significantly between mammals, some HRV
measures need to be adapted to the mammal whose data are being analysed. As an example, the following figure
illustrates the important differences in the location of the characteristic power spectral peaks in analysing RR time
series from different mammals using power spectral analysis. This highlights the need to re-define the spectral bands
(VLF, LF and HF) for each mammal.

AT ’ B3
Zo.05; uman Z 01 Dog
ko) —Welch ko) —Welch
20,04} AR >0.08} —AR
G G |
80.03 ﬁ| 20.06 ’|
_ I _ ‘ [j
£0.02 || £0.04 ‘
] | || J U \
(] VL a \
£0.01 II“""“”\' £0.02 l'}? | }"‘M M
- ] = ‘I‘ l
5 0 0.2 0.4 06 o 0 0.5 1
Frequency (Hz) Frequency (Hz)
C = 4 . DN 3
T _ x10 Rabbit T x10 Mouse
=87 =157
3 7We|ch 3 7Welch
26 AR > —AR
L 2 1
] (&)
= -
*§ § 0.5
2
Q. \ [oR
n n
a mhdmll L Jﬁl | FEP——— ) a M‘ ,
z0 z 0
2 0.5 1 15 & 0 2 4 6
o o

Frequency (Hz)

1.5.3 Performing HRV analysis

Frequency (Hz)

Start by loading some example data by clicking File -> Open data file -> mouse/Mouse_example_qrs.txt. The program
will start the analysis automatically and display the following window:

16
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@ PhysioZoo
File Peak Detection
Main Single

Options  Display

File name Mouse_example_qrs.txt

Signal quality file name

A

C:\Users\Ji

02

him.T-BM-YY-L6\D
T T

physiozoo-tool box-8d644191c063\ExamplesTX Timouse\Mouse_example_grs.xt
T T T T T T T

Auto Compute

Time series length

00:39:37.784 h:min:sec msec

s
B
o
Mammal Mouse 2 g
& 005
Integration level ECG >
o}
Preprocessing WMoving average v
-005 - n . \
Preprocessing level Default v

Default frequency method \welch

p mwmﬁ:ﬁhmﬁm oy

Time series
I I L I

Selected filtered time series
I L I

Plot HR
1

00:00:00 00:00:50 00:01:40 00:02:30 00:03:20 00:04:10 00:05:00 00:05:50 00:06:40 00:07:30 00:08:20

Time (h:min:sec)

0.2
0.1
n L

L L
00:16:40 00:25:00

N N

00:00:00 00:08:20 00:33:20
Statistics Time Frequency | NonLinear
Description Values
AVNN (ms) |Average NN interval duration 106.34 &
SDNN (ms) Standard deviation of NN interval duration 11.89
RMSSD (ms) The square root of the mean of the sum of the squares of differences between adjacent NN intervals 6.05 C
NN (%) Percent of NN interval differences greater than 5.0milliseconds 2723
SEM (ms) Standard error of the mean NN interval 029
PIP (%) Percentage of inflection points in the NN interval time series 36.66
1ALS (nu) Inverse average length of the acceleration/deceleration segments 037
PSS (%) Percentage of short segments 3074
PAS (%) The percentage of NN intervals in alternation segments 837
B WELCH (nu) Slope of the linear interpolation of the spectrum in a log-log scale for frequencies below the upper bound of the VLF band 0.34
HF NORM WELCH (%) High frequency power in normalized units: HF/(Total power - VLF)*100 (welch) 19.03
HF PEAK WELCH (H2) Peak frequency in the high frequency band (welch) 137
HF WELCH (ms2) Power in the high frequency band (welch) 1120
LF NORM WELCH (%) Low frequency power in normalized units: LF/(Total power - VLF)*100 (welch) 80.97
LF PEAK WELCH (Hz) Peak frequency in the low frequency band (welch) 027
LF WELCH (ms"2) Power in the low frequency band (welch) 4764 5

In the upper figure (A) the selected window (colored in blue) defines the time interval for which the HRV measures
are computed. In the lower panel (B), the RR time series is plotted. Two windows are drawn on it: one window with
a red frame and one with a blue frame (and alpha color from within.) The red window defines the part of the RR
time series plotted in the larger upper figure (A). The blue frame defines the part of the RR time series for which the
HRV measures will be computed. The window can be modified (extended/shrunk/moved) using the mouse. Pannel
(C) shows all the HRV measures that have been computed.

Congrats! You have made your first HRV analysis with PhysioZoo!

Note: Every time you move the analysis window to another location the newly selected segment will be automatically
analyzed. You can disable this by deselecting the checkbox “Auto Compute” located under the “Compute” button.

Note: The length of the selected window is important. Some HRV measures assume that the RR time series is
stationary over the selected window. In our context stationary means that the statistical properties of the RR time
series (such as mean and standard deviation) are about constant. Other measures such as the detrended fluctuation
analysis ones do not assume stationarity and thus a long window may be used.

1.5.4 Exporting HRV measures

You can export the HRV measures and prefiltered NN intervals generated by PhysioZoo. Go to File -> Save HRV
measures. The following window will display:
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4 Save HRV Measures Options - O s

Select measures to save:

HRV Measures
PSD Measures
MSE Measures
Filtered Data

Save As Cancel

You can select the computation(s) you want to save with the checkboxes:
* HRV Measures: The HRV measures as displayed in the ‘Statistics section’ of the user interface.

* Power Spectral Density: the measure of signal’s power content versus frequency. This corresponds to saving
the power content for each frequency bin of the power spectral density displayed under the ‘Frequency tab’.

¢ Multi Scale Entropy: the value of sample entropy for a range of scales as specified under Options->NonLinear
and displayed under the ‘NonLinear tab’.

* Preprocessed RR intervals: the RR interval time series after it was preprocessed by the filter you specified
under Main-> Preprocessing. The resulting preprocessed time series is traditionally called the ‘NN’ time series.

Select the location where you want to save the HRV measures. Open the HRV Measures file and you will see the list
of HRV measures together with their definitions and values for the window that was selected. For that purpose open
the text file (Mouse_example_qrs_hrv.txt) you just saved.
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| Mouse_example_ars_hrv - Notepad
File Edit Format View Help
fvnn (ms)

SDNN (ms)

RMSSD (ms)

pNNS (%)

SEM (ms)

PIP (%)

IALS (n.u.)

PSS (%)

PAS (%)

BETA_WELCH (n.u.)
HF_NORM_WELCH (%)
HF_PEAK_WELCH (Hz)
HF_POWER_WELCH (ms~2)
LF_NORM_WELCH (%)
LF_PEAK_WELCH (Hz)
LF_POWER_WELCH (ms*2)
LF_TO_HF_WELCH (n.u.)
TOTAL_POWER_WELCH (msn2):
VLF_NORM_WELCH (%)
VLF_POWER_WELCH (msA2)
BETA_AR (n.u.)
HF_NORM_AR (%)
HF_PEAK_AR (Hz)
HF_POWER_AR (msA2)
LF_NORM_AR (%)
LF_PEAK_AR (Hz)
LF_POWER_AR (ms~2)
LF_TO_HF_AR (n.u.)
TOTAL_POWER_AR (ms*2)
VLF_NORM_AR (%)
VLF_POWER_AR (msA2)
SD1 (ms)

SD2 (ms)

alphail (n.u.)

alpha2 (n.u.)

SampEn (n.u.)

Average NN interval duration

Standard deviation of NN interval duration

The square root of the mean of the sum of the squares of differences between adjacent NN intervals
percent of NN interval differences greater than 5.emilliseconds

standard error of the mean NN interval

Percentage of inflection points in the NN interval time series

Inverse average length of the acceleration/deceleration segments

Percentage of short segments

The percentage of NN intervals in alternation segments

Slope of the linear interpolation of the spectrum in a log-log scale for frequencies below the upper bound of the VLF band
High frequency power in normalized units: HF/(Total power - VLF)*100 (welch)
Peak frequency in the high frequency band (welch)

power in the high frequency band (welch)

Low frequency power in normalized units: LF/(Total power - VLF)*1@0 (welch)
Peak frequency in the low frequency band (welch)

Power in the low frequency band (welch)

Low frequency band to high frequency band power ratio (LF/HF) (welch)

Total power (welch)

Very low frequency power in normalized units: (welch)

Power in the very low frequency band (welch)

Slope of the linear interpolation of the spectrum in a log-log scale for frequencies below the upper bound of the VvLF band
High frequency power in normalized units: HF/(Total power - VLF)*10@ (ar)
Peak frequency in the high frequency band (ar)

Power in the high frequency band (ar)

Low frequency power in normalized units: LF/(Total power - VLF)*100 (ar)

peak frequency in the low frequency band (ar)

Power in the low frequency band (ar)

Low frequency band to high frequency band power ratio (LF/HF) (ar)

Total power (ar)

very low frequency power in normalized units: (ar)

Power in the very low frequency band (ar)

NN interval standard deviation along the perpendicular to the line-of-identity
NN interval standard deviation along the line-of-identity

DFA low-scale slope

DFA high-scale slope

Sample entropy

1.5.5 Exporting figures

106.34
11.89
6.05
27.23
0.29
36.66
8.37
36.74

-0.34
19.03
1.37
11.20
80.97
9.27
47.64
4.25
117.94
45.54
53.71
-8.85
20.95
1.45
7.11
79.05

26.82
3.77
69.77
47.74
33.31
4.28
16.19
1.32
0.96
9.88

Figures can be exported in high quality format and thus easily included in your research reports or papers. For
exporting figures click File -> Export figures. You will be prompted with the following window on which you can
choose what figures you want to export. After clicking ‘Save As’ you will be able to choose the format of the figure.

4. Save Figures Options — O b

Select figures to save:
| NN Interval Distribution

| Power Spectral Density
| Beta

| DFA

| MSE

| Poincare Ellipse

| RR Time Series

Save As Cancel

1.5. Heart Rate Variability analysis
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1.5.6 Consecutive windows analysis

You might want to track the evolution of the HRV measures over time: for example, if you are injecting some drug to
the mammal and want to observe the resulting changes on the HRV measures over time. For that purpose PhysioZoo
enables the analysis to be performed on consecutive segments.

Let’s use a long RR time series: File -> Open data file -> Mouse_example_qrs

Click the “Single” Submenu in the left panel and click on the “Use full length” button. Then press the “Compute”
button located on the top right of the interface. You will see the following screen, which contains all the HRV measures
for each consecutive window over the whole recording.

@ PhysioZoo - X
File Peak Detection 1
Main Single | Options  Display C:\U Joachi T—BM—YY—L&\E P i physiozoo-toolbox-8i644 191c063\ExamplesTX Tmouse\Mouse_example_grs.txt
; T T T
Batch analysis | i TR o
Segment start 00:00:00 | himin:sec Plot HR
Segment end 00:39:37 |h:min:sec [(ESAIETG 02 '”mk f,l’
°
Window length 00:03:00 | h:min:sec 8 Mhap b
g il ¢ ] m Wiy W " f
Overlap 0 % z o1 Wby 1 e w., m» o u, e I A' a ‘:\‘!W 'W‘ W Wf"‘mﬂf MM l )”
Selected window 1 «
Number of windows 13 of 1
Time series Selected filtered time series
01k . . . . B
00:00:00 00:08:20 00:16:40 00:25:00 00:33:20
Time (h:min:sec)
00:00:00 00:08:20 00:16:40 00:25:00 00:33:20 A- A-
Statistics Time Frequency | NonLinear
Description w1 w2 w3 W4 W5 W6 W7
AVNN (ms) |Average NN interval duration 106.34 105.94 103.58 107.91 108.49 119.05 11471 104
SDNN (ms) Standard deviation of NN interval duration 11.89 1137 1038 862 1019  11.76 1161 10
RMSSD (ms) The square root of the mean of the sum of the squares of differences between adjacent NN intervals 6.05 5.47 4.96 510 5.02 7.40 637 XS
PNNS5 (%) Percent of NN interval differences greater than 5.0milliseconds 27.23 23.77 2225 22.58 20.52 37.46 29.06 19
SEM (ms) Standard error of the mean NN interval 029 0.28 0.25 021 0.25 030 0.29 0.
PIP (%) Percentage of inflection points in the NN interval time series 36.66 33.23 3538 41.40 38.66 46.21 44.62 36
1ALS (nu) Inverse average length of the acceleration/deceleration segments 037 033 035 0.41 039 0.46 0.45 0.
PSS (%) Percentage of short segments 30.74 24.06 27.50 3591 32.06 42.95 41.03 30
PAS (%) The percentage of NN intervals in alternation segments 8.37 5.10 6.20 12.07 10.65 19.48 14.87 9.2
B WELCH (nu) Slope of the linear interpolation of the spectrum in a log-log scale for frequencies below the upper bound of the VLF band -0.34 124 -0.70 -1.19 -1.45 -0.94 -0.64 0.
HF NORM WELCH (%) High frequency power in normalized units: HF/(Total power - VLF)*100 (welch) 19.03 1407  17.81 2144 1932 2434 2219 10
HF PEAK WELCH (Hz) Peak frequency in the high frequency band (welch) 137 136 1.94 127 167 1.90 1.40 1:
HF WELCH (ms”2) Power in the high frequency band (welch) 1120 1292 871 839 774 1792 793 ac
LF NORM WELCH (%) Low frequency power in normalized units: LF/(Total power - VLF)*100 {welch) 8097 8593 8219 7856 8068 7566 7781 89
Peak frequency in equency band (welch) 0.27 027 0.17 020 0.44 026 027 0.
IDAwiar in tha lau hand hualch) AT RA 72 02 A0 9N anTa 2721 &5 7n 2770 20 Y
< >

You can also enable the analysis window to be overlapping by using the “Overlap” entry in the Analysis menu. By
default the value is 0% (i.e. no overlap between successive windows). Change it to 50% and re-run the analysis.

You can export all HRV measures from all consecutive windows (Main -> Save HRV measures as).

If you want to export figures, then select with the mouse the window you want to save the figures for.

Note: While using the successive segment analysis feature, it is possible to export the HRV measures and PSD from
all the analyzed consecutive windows together. However, you can only export the figures from one single window at
the time i.e. from the window that you select with the mouse (i.e. the ‘selected window”).

1.5.7 Adapting HRV measures to alternative mammals

If you want to adapt the HRV measures to other mammals you can create a new ‘Configuration file’ (see here) with
parameters suitable to the specie you are studying. For some of the HRV measures (power frequency bands and
pNNxx) you will find a button ‘E’ next to their parameters value under Options->Time/Frequency. You can use click
on this button to adapt the HRV measure to the alternative mammalian model you are using.
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Main Single Options Display

Filtering Time Frequency MonLinear

AR order 30 n.u.

[3 band 0.0056 |- 0152 |Hz

HF Band 124 |- 5 Hz

LF Band 0152 |- 124 H
VLF Band 0.0056 |- 0152 |Hz
Welch overlap 50 %
Spectral window length 00:03:00 h:min:sec

[ ]Use window average

1.6 Signal quality annotations

In this tutorial you will learn how to perform signal quality annotations within the PhysioZoo Peak detection
module and how to use these for your analysis in order to provide contextual information.

1.6.1 Introduction

PhysioZoo allows you to annotate and load signal quality annotations, which contain time intervals with quality
annotations made on the original electrophysiological signal time series. The annotations highlight parts of the RR
time series which are not to be trusted because the underlying ECG was of bad quality and the peak detector might have
failed in estimating the heart rate within these intervals or just because you want to exclude these segments because
they correspond to some transition period during drug injection and so you decide to label these time periods as ‘bad
quality’.

1.6.2 Annotating signal quality

To annotate the quality of an electrophysiological signal time series, follow these steps:
1. Select the rabbit ECG example: File-> Open data file-> Rabbit_example.txt
2. Under the record panel, select Annotation -> Signal quality. See the red rectangle on the figure below.

3. Look for a segment with some bad quality data and draw a rectangle around it with the mouse. The background
of the area you have selected will become red.
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PhysioZoo_PeakDetection - X
File »
Record Configuration Display Ci\Users\Joachim. T-BM-YY-L6\Desktop! i0z00-physiozoo-toolbox-8d644191c06: \plesTXT\rabbi it_example_ecg.txt | compute |
Record file name Rabbit_example_ecg txt = 6 [“1Auto Com
\
Peaks file name: 4l \ \ Plot HR
Sttty o e s, | |
z 2
Time series length 0:26:0.277 h:min:sec.msec o + ‘
S0 J +
w
Mammal Rabbit v | ‘
2b
Integration level ECG v ‘
Peak defector rars o i I I I | L
00:18:00 00:18:10 00:18:20 00:18:30 00:18:40 00:18:50
Annotation Signal quality ~ Time (sec)
Class c v s 1k 1
- l
[ S ‘p S U N " | — ,%,,;MU,‘,,M
= ok L L | — L
‘ 5
| 00:00:00 00:08:20 00:16:40 00:25:00 gg
Description Values
NB PEAKS (n.u) Total number of peaks 5449
NB PEAKS ADD (n.1) Number of peaks manually added by the user 0
NB PEAKS RM (1) Number of peaks manually removed by the user 0
PR BAD 5Q (%) Percentage of the record annotated as bad quality (ie. signal quality = 'A") 0.7381

In PhysioZoo we define three levels of signal quality:

* “A”: good quality signal where HRV and morphological analysis of the electrophysiological signal are possible.
This means that the waveform is clean enough to detect the beats and to also study its morphology.

* “B”: average quality signal where the beats can be detected and thus HRV analysis is possible but the signal
quality is not good enough for morphological analysis.

* “C”: bad quality signal. Neither HRV or morphological analysis is possible.

1.6.3 Loading signal quality

When using a recording for which you have performed signal quality annotations, you can load the signal quality
annotations: Open -> Open signal quality file.

After the quality annotations are loaded, you will see a bar with green and red parts appearing on the top of the RR
interval time series figure. The part in green corresponds to good quality data (i.e. data which analysis can be trusted)
and the part in red corresponds to bad quality data (i.e. data which should not be trusted.) In addition, the RR time
series is highlighted in red for the intervals which are indicated as bad quality.
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P physiozoo - X
File Peak Detection L
Main | Single  Options  Display C:\Users\oachim. T-BM-YY-L6\D 0200-physioz00-toolbox-8d644 191C06: TXTwrabbil it example._qrs.bd [ Compute |
- T T T - T T T
File name Rabbit_example_qrs. it 045 p—
Signal quality file name  Rabbit_example_ecg_quality.txt e | | PotHrR |
0351 [ Reset |
Time series length 00:25:50.074  h:min:sec_msec 5 Reset
& 03 WWMWWAW M\rl\v
Mammal Rabbit v x
© 025
Integration level ECG v
- 02
IEEEEs Moving average e 0 Time series Selected filtered time series Bad quality
Preprocessing level Default v . . L . L L
00:17:20 00:17:40 00:18:00 00:18:20 00:18:40 00:19:00
Default frequency method \yeich ~ Time (h:min:sec)
0.4
035
L N
oo Mﬂ Py Y g by
I I I AA
00:00:00 00:08:20 00:16:40 00:25:00 KNS
Statistics Time Frequency | NonLinear
Description Values
AVNN (ms) Average NN interval duration 278.06 ~
SDNN (ms) Standard deviation of NN interval duration 8.82
RMSSD (ms) The square root of the mean of the sum of the squares of differences between adjacent NN intervals 5.17
PNN17 (%) Percent of NN interval differences greater than 17.0milliseconds 0.37
SEM (ms) Standard error of the mean NN interval 0.27
PIP (%) Percentage of inflection points in the NN interval time series 49.68
1ALS (nu) Inverse average length of the acceleration/deceleration segments 0.50
PSS (%) Percentage of short segments 4875
PAS (%) The percentage of NN intervals in alternation segments 20.67
B WELCH (nu) Slope of the linear interpolation of the spectrum i a log-log scale for frequencies below the upper bound of the VLF band 057
HE NORM WELCH (%) High frequency power in normalized units: HF/(Total power - VLF)*100 (welch) 4215
HF PEAK WELCH (H2) Peak frequency in the high frequency band (welch) 072
HE WELCH (msh2) Power in the high frequency band (welch) 7.76
LF NORM WELCH (%) Low frequency power in normalized units: LF/(Total power - VLF)*100 (welch) 57.85
LF PEAK WELCH (H2) Peak frequency in the low frequency band (welch) 0.14
LF WELCH (ms2) Power in the low frequency band (welch) 1065 .

1.6.4 Frequently asked questions

When do we need to make signal quality annotations?

Small bad quality segments (few of beats) will be ‘cleaned up’ by the prefiltering step and so one should not worry too
much about it. The signal quality annotations are more useful when a ‘large’ section of the recording is of bad quality

in which case the prefiltering step will be useless or even misleading. Analysing such sections with large segments of
bad quality data will provide meaningless results - the signal quality annotations are useful to prevent that.

1.7 Importing data

In this tutorial you will learn how to import data in PhysioZoo.

1.7.1 Introduction

Data loading in PhysioZoo is centralized and done through the PZ Loader tool. Three types of input formats are
supported by PhysioZoo - see formats supported.

1.7.2 Concepts

* PZ Loader: three types of formats can be loaded in PhysioZoo. This is done through the PZ Loader. The
PZ Loader will ensure that the data that enter the PZ-UT are properly formatted.

* Header: itis possible to include a header at the beginning of a record. This header will specify all the information
that PhysioZoo needs to open a record. If all the information is specified in the header, then you will not need
to go through populating the PZ Loader User Interface and the record will be directly opened in PhysioZoo.
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See here for the formats supported and how to create PhysioZoo headers.

The figure below illustrates the pathway for loading a recording: the PZ Loader is used to load a recording from
one of the supported formats. If no header is available, then the PZ Loader user interface is opened and the user is
prompted to enter the necessary information. If the header is available, then the record is directly loaded in PhysioZoo.

PZ Loader
User interface
WFDB
Text (.txt) —— | 274 LoE 1[5 Header? PhysioZoo
Matlab
(.mat)

In this tutorial we will see how to make use of the PZ Loader user interface (UI) when no header is available.

1.7.3 PZ Loader User Interface

Open an example annotation file:
Download the following example file and load it in PhysioZoo.

In case some information is missing from the file (e.g. mammal type is not available in the header) then the PZ
Loader will request the corresponding fields to be filled by the user. When all the fields have been filled then click
OK and the data will be opened in PhysioZoo.

For the example provided, fill the fields as in the screenshot below and click OK:
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PZ Loader

File name: Dog_05_eg_no_header

rGeneral ‘Channels

Time
Integration level |e|ectrocardiogram V| = 500 Name |Ch01 V‘ Unit |second v|
Mammal |d09 "|

Data

Type Name | Ch02 ~ Unit milivolt |

0.4 —

V00 ¥ Y ¥ _

| | | | | | | | |
0 0.5 1 1.5 2 25 3 3.5 4 4.5
Time (sec)

OK Cancel

1.8 Formats supported

Amplitude (millivolt)
[=}

In this tutorial you will learn about how to prepare your data for importing them in PhysioZoo. Data samples are
available here.

1.8.1 Introduction

PhysioZoo supports three types of formats:
* WFDB,
o text (.txt),
¢ MATLAB (.mat).

The .txt and .mat files structures are specific to PhysioZoo whereas the WFDB follows the standard structure of WFDB
powered by Physionet (physionet.org) with some additional fields in the WFDB header files. If you are experienced
with WFDB then we recommend you use this format.

For any of the three formats a file consists of a “header” and the “data”:
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Mammal :
Fs:

dog
500

Integration level: electrocardiogram

Channels:

- type:
name :
unit:
enable:

- type:
name :
unit:
enable:

time
time
second
yes

electrography
data
millivolt

yes

0.000000 0.060057
0.002000 0.064323
0.004000 0.068589
0.006e000 0.073524
0.008000 0.077790
0.010000 0.080550
0.012000 0.08356l
0.014000 0.085987
0.01le000 0.088747
0.018000 0.090002
0.020000 0.090002

— Header

— Data

Note: When downloading PhysioZoo a set of examples (WFDB,.txt and .mat) are provided with the structure that is
needed in PhysioZoo. You can use these as examples for formatting your own recordings.

1.8.2 General structure of the Header

For each of the files the following information can be specified in the header:

* Mammal: the name of the mammal (e.g. ‘dog’, ‘mouse’, ‘rabbit’, ‘human’),

* Fs: the sampling frequency in Hertz,

* Integration_Level: ‘electrocardiogram’, ‘electrogram’ or ‘action potential’.

As part of the header, information characterizing each channel available can be entered:

e type: ‘peak’, ‘signal quality’, ‘time’, ‘interval’, ‘beating rate’ and ‘electrography’. See definitions of these in
ype: p gnal q y g grapny

the next section,

* name: a name you want to give to the channel (of note this information is not used by the PZ Loader to load the

data),

* unit: ‘millisecond’, ‘second’, ‘index’, ‘bpm’, ‘millivolt’, ‘microvolt’ and ‘volt’,

 enable: ‘yes’ or ‘no’. If you specify ‘no’ then this channel will be ignored when the file is loaded by the PZ

Loader. Only specify ‘yes’ for the channels you want to use.

In the case all or some of this information is missing from the Header then you will be prompted to enter it through

the PZ Loader User Interface.

26

Chapter 1. Introduction


../tutorials/pzloader.html
../tutorials/pzloader.html

PhysioZoo Documentation

1.8.3 Channels Type

There are two categories of Channels: ‘Annotations’ and ‘Time series’. Within these two categories the Channel can
be one of the following type’s (specified in the header):

Annotations

* ‘peak’: the location of the peaks (e.g. R-peak from an ECG time series). The peak locations can be
specified in millisecond/second or index.

 ‘signal quality’: annotation on the signal quality. The signal quality annotations can be specified in mil-
lisecond/second or index.

Time series

* ‘time’: a time vector giving the position of each sample of another time series. An entry of type ‘time’
needs to be associated with another time series and must be in units of seconds or milliseconds.

* ‘interval’: the time interval between consecutive beats (e.g. RR time series). The interval length can be
specified in second/millisecond or index.

* ‘beating rate’: the reciprocal of the interval in units of beats per minute (e.g. heart rate).

¢ ‘electrography’: the amplitude of an electrography time series (e.g. ECG). The electrography amplitude is
given in microvolt, millivolt or volt. Thus only physiological units are allowed.

1.8.4 Headers in the different formats

Explanation of the structure of the different formats supported is provided below. Examples in all formats are also
available in the ‘Examples’ folder provided with the PhysioZoo download.

Text format (.txt)

1.8. Formats supported 27



PhysioZoo Documentation

Mammal :
Fs:

Integration_level: electrocardiogram

Channels:

- type:
name :
unit:
enable:

- type:
name :
unit:
enable:

dog
500

time
time
second
yes

electrography
data
millivolt

yes

0.000000 0.060057
0.002000 0.064323
0.004000 0.068589
0.006e000 0.073524
0.008000 0.077790
0.010000 0.080550
0.012000 0.08356l
0.014000 0.085987
0.01le000 0.088747
0.018000 0.090002
0.020000 0.090002

— Header

— Data

Matlab format (.mat)
A .mat file needs to contain the following fields:
| Channels = |
[E] 1x1 struct with 4 fields
Field + |"-.f’alue
abc| AMe 'data'
enable 'ves'
type 'alectrography
Jaod unit ot

The Channels field is a Cell. Each element of the Channel Cell will contain the following fields : ‘type’, ‘name’, ‘unit’

and ‘enable’.

WFDB (.hea)

WEFDB files (annotation or data) will be accompanied by a header (.hea) file specifying the relevant information for
reading an annotation or data file. Refer to the WFDB documentation for that. To the standard WFDB format of the
header, you will need to add one comment line at the end of the header and starting ‘#’ then followed by the mammal

type and the integration level.
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Dog 01 1 500 134258

Dog 0l.dat 16 51300.0027(-1159)/mV 0 0 —-1487 25886 0 Data
(electrography)

#Mammal :dog, Integration level:electrocardiogram

1.8.5 Frequently asked questions

What if | am used to another format?

For now PhysioZoo only supports the WFDB, text and Matlab formats. Most commercial softwares enable you to
export your data in text format which you can then import in PhysioZoo using the PZ Loader (see here).

Is there a way to import data without a formatted header?

Yes you can use the PZ Loader (see here) to import data which do not have a Header. You will use the PZ Loader
User Interface to fill in the information needed and it will be opened in PhysioZoo.

1.9 Configuration files

In this tutorial you will learn how to create your custom configuration files for R-peak detection and for performing
HRYV analysis.

Note: In the next version of PhysioZoo the two configuration files will be merged in one unique configuration file.

1.9.1 Introduction

PhysioZoo enables you to work with HRV data from different mammals. Since the beating rate and its variability
patterns vary across species then some parameters of the peak detectors and of the time, frequency and nonlinear HRV
measures must be adjusted.

In the current version of the software these adaptations are readily available for the processing of Human, dog, rabbit
and mouse electrocardiographic data. For processing data from other species or if you are using other data than ECG
(e.g. electrogram, action potential) you will need to define your own configuration files. There are two types of
configuration files in PhysioZoo: the peak detection configuration file and the HRV configuration file.

1.9.2 PhysioZoo software

Defining a peak detector configuration file

In the Peak detection module:

1. By choosing Mammal->Custom this will prompt you with a selection window. Select the configuration file of
the closest mammal to the one you want to use. This will set the default HRV configuration parameters. Follow
the following steps:

2. Modify the configuration of the peak detector you choose to use uder Configuration.
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3. Save the peak detector configuration by clicking File -> Save configuration file.

4. To use this configuration file when you next use the PhysioZoo peak detection module: (1) File->Load custom
config file or (2) Main->Mammal->Custom and choose your configuration file.

_| gqrs.custom - Notepad — O

File Edit Format View Help

# gqrs temp config file for custom parameters:
HR 608

QRSa 109@

QRSamin 37@

Qs 9.00718

QT 0.03

RRmax 9.24

RRmin  @.@5

hct 300
lcf 3

rp 0.030
thr 2.5
W5 1@

Defining an HRV configuration file

In the HRV module: under the “Main” tab you can change the Mammal type to one of the following options: Human,
Dog, Rabbit, Mouse and Custom. In built in the software are configuration files for human, dog, rabbit and mouse
electrocardiographic data. By choosing thee “Custom” option under ‘Mammal’ you can define an HRV configuration
file of your own. Follow the following steps:

1. By choosing Mammal->Custom this will prompt you with a selection window. Select the configuration file of
the closest mammal to the one you want to use. This will set the default HRV configuration parameters.

2. Modify some of the HRV measures configuration by going to the “Options” menu (see screenshot below.) There
you will find all the parameters of the HRV measures sorted with respect to their category: Time, Frequency and
Nonlinear as well as the Preprocessing parameters. If, as an example, you want to change the cut-off frequency
between the low frequency and high frequency bands (“LF Band” and “HF Band”) in the frequency based
methods then you can do so by changing the 0.341 Hz (see screen below) value to something else more suited
to your data.

3. Go to File->Save config file and save the configuration file under the name of the mammal you are using.

4. To use this configuration file when you next use PhysioZoo HRV module: (1) File->Load custom config file or
(2) Main->Mammal->Custom and choose your configuration file.
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File Help Peak Detection

Record = Analysis  Options Display Group
Peaks file name qrs_Rabbit_02_part 4 mat =

Quality file name

Time series length 00:25:59 988 h:min:sec.msec
Mammal Rabhit w
Integration level Human

Human (Task Force)
Preprocessing Dog
Preprocessing level Mouse

Custom

Default frequency method yyeprm

q o[

File Help Peak Detection

Record  Analysis  Options Display Group

Filtering Time Frequency MNonLinear
AR order 20 n.u.
¢ band 0.0033 |-| 0.088 Hz
HF Band 0.341 - Hz
LF Band 0.088 Hz &
VLF Band 0.0033 |-| 0.088 Hz
Welch overlap 50 %
Spectral window length 00:05:00 h :min-sec

[ 1Use window average

1.9. Configuration files
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1.9.3 Frequently asked questions

Why configuration files?

The beating rate and its variability pattern vary across species thus some parameters of the peak detectors and of the
time, frequency and nonlinear HRV measures must be adjusted.
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CHAPTER 2

mhrv toolbox documentation

mhrv is a matlab toolbox for calculating Heart-Rate Variability (HRV) metrics from both ECG signals and RR-interval
time series. The toolbox works with ECG data in the PhysioNet WFDB data format.

2.1

WFDB wrappers and helpers. A small subset of the PhysioNet WFDB tools are wrapped with matlab func-
tions, to allow using them directly from matlab.

ECG signal processing. Peak detection and RR interval extraction from ECG data in PhysioNet format.

RR-intervals signal processing. Ectopic beat rejection, frequency filtering, nonlinear dynamic and fractal
analysis.

HRYV Metrics. Calculating quantitative measures that indicate the activity of the heart based on RR intervals
using all standard HRV metrics defined in the literature.

Configuration. The toolbox is fully configurable with many user-adjustable parameters. Everything can be
configured either globally with human readable YAML config files, or when calling the toolbox functions via
matlab style key-value pair arguments.

Plotting. All toolbox functions support plotting their output for data visualization. The plotting code is separated
from the algorithmic code in order to simplify embedding this toolbox in other matlab applications.

Top-level analysis functions. These functions work with PhysioNet records and allow streamlined HRV anal-
ysis by composing the functions of this toolbox. Supports multi-record batch analysis for calculating HRV
features of large datasets.

Getting Started

2.1.1 Requirements

Matlab with Signal Processing toolbox. Should work on Matlab R2014b or newer.

The PhysioNet WFDB tools. The toolbox can install this for you.
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2.1.2 Installation

1. Clone the repo or download the source code.
2. From matlab, run the mhrv_init function from the root of the repo. This function will:

* Check for the presence of the WFDB tools in your system PATH. If WFDB tools are not detected, it will
attempt to automatically download them for you into the folder bin/wfdb under the repository root.

» Set up your MATLAB path to include the code from this toolbox.

Notes about matlab’s pwd and path

Matlab maintains a PWD, or “present working directory”. It’s the folder you see at the top of the interface, containing
the files you see in the file explorer pane. Type pwd at the matlab command prompt to see it’s value.

Additionally, matlab maintains a PATH variable, containing a list of folders in which it searches for function definitions
(similar to the shell PATH concept). Type path at the matlab command prompt to see it’s value.

You don’t need to change your pwd to the root of the repo folder for the toolbox to work. You can simple run the
mhrv_init function from your current pwd, and it will take care of updating matlab’s path. For example, if you
cloned or downloaded the toolbox in the folder /Users/myname/mhrv/, you can run the following command
from the matlab prompt:

run /Users/myname/mhrv/mhrv_init.m

After this the toolbox will be ready to use, regardless of your pwd.

Manual WFDB Installation (Optional)

The above steps should be enough to get most users started. If however you don’t want mhrv_init to download the
WEFDB tools for you, or the automatic installation fails for some reason, you can install them yourself.

* On OSX, you can use homebrew to install it easily with brew install wfdb.

* On Windows and Linux, you should either download the WFDB binaries for your OS or compile them from
source using the instructions on their website.

Once you have the binaries, place them in some folder on your $PATH or somewere under the repo’s root folder (bin/
wfdb would be a good choice as it’s . git ignored) and they will be found and used automatically. Or, if you would
like to manually specify a path outside the repo which contains the WFDB binaries (e.g. /usr/local/bin for a
homebrew install), you can edit defaults.yml and set the mhrv.paths.wfdb_path variable to the desired path.

For linux users it’s recommended to install from source as the binaries provided on the PhysioNet website are very
outdated.

2.2 mhrv

The top level analysis functions in mhrv can be used as a command-based user interface to the toolbox. The mhrv ()
and mhrv_batch () functions allow analysis of both ECG and R-peak annotation files in WFDB format and return
all HRV metrics supported by the toolbox.
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2.2.1 mhrv ()

mhrv.mhrv (rec_name, varargin)
Analyzes an ECG signal, detects and filters R-peaks and calculates various heart-rate variability (HRV) metrics
on them.

Parameters

* rec_name — Path and name of a wfdb record’s files e.g. db/mitdb/100 if the record files
(both 100.dat and 100.hea) are in a folder named ‘db/mitdb’ relative to MATLABs pwd.

* varargin — Pass in name-value pairs to configure advanced options.

— ecg_channel: The channel number to use (in case the record has more than one). If not
provided, mhrv will attempt to use the first channel that has ECG data.

— ann_ext: Specify an annotation file extention to use instead of loading the record itself
(.dat file). If provided, RR intervals will be loaded from the annotation file instead of
from the ECG. Default: empty (don’t use annotation).

— window_minutes: Split ECG signal into windows of the specified length (in minutes) and
perform the analysis on each window separately.

— window_index_offset: Number of windows to skip from the beginning.

— window_index_limit: Maximal number of windows to process. Combined with the
above, this allows control of which window to start from and how many windows to
process from there.

— params: Name of mhrv defaults file to use (e.g. ‘canine’). Default *’, i.e. no parameters
file will be loaded. Alternatively, can also be a cell array containing the exact arguments
to pass to mhrv_load_params. This allows overriding parameters from a script.

— transform_fn: A function handle to apply to the NN intervals before calculating metrics.
The function handle should accept one argument only, the NN interval lengths.

— plot: true/false whether to generate plots. Defaults to true if no output arguments were
specified.

Returns

e hrv_metrics: A table where each row is a window and each column is an HRV metrics that
was calculated in that window.

* hrv_stats: A table containing various statistics about each metric, calculated over all win-
dows.

* plot_datas: Cell array containing the plot_data structs for each window.

2.2.2 mhrv_batch ()

mhrv.mhrv_batch (rec_dir, varargin)
Performs batch processing of multiple records with mhrv.

This function analyzes multiple physionet records with mhrv and outputs tables containting the results. The
records to analyze can be subdivided into record types, in which case output tables will be generated for each
record type. Optionally, an Excel file can be generated containing the results of the analysis, including a com-
parison of the results per group.

Parameters

* rec_dir - Directory to scan for input files.
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Returns

varargin — Optional key-value parameter pairs.
— rec_types: A cell array containing the names of the type of record to analyze.

— rec_filenames: A cell array with identical length as ‘rec_names’, containing patterns to
match against the files in ‘rec_dir’ for each ‘rec_type’.

— rec_transforms: A cell array of transform functions to apply to each file in each record
(one transform for each rec_type).

— ann_ext: Specify an annotation file extention to use instead of loading the record itself
(.dat file). If provided, RR intervals will be loaded from the annotation file instead of
from the ECG. Can also be a cell-array of strings the same length as rec types. This
allows using a different annotator extension for each rec type. Default: empty string
(don’t use annotation).

— min_nn: Set a minumum number of NN intervals so that windows with less will be dis-
carded. Default is O (don’t discard anything).

— rr_dist_max: Sanity threshold for RR interval distribution. Windows where
mean(RR)+2std(RR) > rr_dist_max will be discarded.

— rr_dist_min: Similar to above, but will discard windows where mean(RR)-2std(RR) <
rr_dist_min.

— mhrv_params: Parameters pass into mhrv when processing each record. Can be either a
string specifying the parameters file name, or it can be a cell array where the first entry
is the parameters file name and the subsequent entires are key-value pairs that override
parameters from the file.

— skip_plot_data: Whether to skip saving the plot data for each record. This can reduce
memory consumption significantly for large batches. Default: false.

— writexls: true/false whether to write the output to an Excel file.
— output_dir: Directory to write output file to.

— output_filename: Desired name of the output file.

A structure, batch_data, containing the following fields:

rec_types: A cell of strings of the names of the record types that were analyzed.
rec_transforms: A cell array of the RR transformation functis used on each record type.

mhrv_window_minutes: Number of minutes in each analysis windows that each record was
split into.

mhrv_params: A cell array containing the value of the params argument passed to mhrv for

the analysis (see mhrv documentation).

hrv_tables: A map from each value in ‘rec_types’ to the table of HRV values for that type.
- stats_tables: A map with keys as above, whose values are summary tables for each type.

plot_datas: A map with keys as above, whose values are also maps, mapping from an indi-
vidual record filename to the matching plot data object (which can be used for generating
plots).
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2.3 mhrv.defaults

2.3.1 mhrv_get_all_defaults()
mhrv.defaults.mhrv_get_all_ defaults (params_struct)
Returns all parameter default values of the mhrv toolbox in a map.

Parameters params_struct — Optional. The parameter structure to work on. If not provided,
this function will search traverse the globally defined toolbox parameters.

The returned map contains keys that correspond the the unique id’s of parameters, e.g dfa.n_max. The map’s
values are structures containing the value of the parameter and metadata fields.

2.3.2 mhrv_get_default ()

mhrv.defaults.mhrv_get_default (param_id, meta)
Returns the default value configured for a parameter. This function attemps to get the value of a parameter as
configured by a user config file. If it can’t find a user-specified default for the parameter, it throws an error.

Parameters

* param_id — Unique id of the parameter This is made up of the keys in the defaults file
leading to the parameter (not including the ‘value’ key), joined by a .’ character (example:
‘hrv_freq.methods’).

* meta — Optional. A fieldname to return from the parameter structure (instead of the struc-
ture itself). Can be value/description/name/units.

Returns
A structure containing the following fields:
¢ value: The user-configured parameter value, if exists, otherwise returns the ‘default_value’.
* name: The user-friendly/display name of the parameter.
* description: A description about the parameter.

* units: The units the parameter is specified in.

Note: If a value for ‘meta’ was specified, only the corresponding field will be returned.

2.3.3 mhrv_load defaults ()

mhrv.defaults.mhrv_load_defaults (varargin)
Loads an mhrv defaults file, setting it’s values as default for all toolbox functions. Optionally, all current
parameter defaults will be cleared.

Usage:

mhrv_load_defaults [-—-clear]
mhrv_load_defaults [-—-clear] <defaults_filename>
mhrv_load_defaults(defaults_filename, 'paraml',6 valuel, 'param2',6 value2, ...)
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This function loads the parameter values from the default mhrv parameters file and sets them as the default value
for the various toolbox functions.

The second usage form loads the parameter values from an arbitrary mhrv parameters file (.yml). The given file
can be a name of a file on the matlab path, or, if it’s not found there, it will be interpreted as a path (absolute or
relative to pwd).

The third usage form also allows overriding or adding specific parameters with custom values given to the
function. In this form, the filename is optional; the function will also accept just key-value pairs.

Note: This function clears all current default parameters if the ‘—clear’ option is given. Otherwise, it merges the
loaded values with the previously existing parameter defaults.

2.3.4 mhrv_parameter ()
mhrv.defaults.mhrv_parameter (value, description, name, units)
Creates a parameter structure for use with the mhrv toolbox.
Parameters
* value — The parameter’s value. Can be any matlab object.
* description — Informative description of the parameter.
* name — User friendly/display name of the parameter.

e units — Parameters units.

Note: All inputs are optional and default to an empty string if not provided.

Returns An object representing the parameter. Can be added to the defaults with the
mhrv_set_default or mhrv_load_defaults functions.

2.3.5 mhrv_save_defaults ()

mhrv.defaults.mhrv_save_defaults (output_filename)
Save the current default values of all parameters defined in the toolbox to a file.

Usage:

mhrv_save_defaults <output_filename>

This function saves the current default values of all parameters in the toolbox to a specified output file. The file
will be in YAML format. If the output_filename parameters doesn’t specify a . ym1 extension, it will be added.

2.3.6 mhrv_set_default ()

mhrv.defaults.mhrv_set_default (varargin)
Sets (overrides) current default parameter value(s) with new values.

Usage:

mhrv_set_default ('paraml', valuel, 'param2',6 wvalue2, ...)
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This function allows overriding specific parameters with custom values given to the function. The input should
consist of key-value pairs, where the keys use the ‘.’ character to separate heirarchy levels (e.g. ‘rqrs.gqconf’).

2.4 mhrv.ecg

2.4.1 bpfilt ()

mhrv.ecqg.bpfilt (ecg, fs, Icf, hef, nt, debug)
This function' is made for prefiltering an ecg time series before it is passed through a peak detector. Of important
note: the upper cut off (hcf) and lower cutoff (Icf) of the bandpass filter that are applied, highly depends on the
mammal that is being considered. This is particularly true for the hcf which will be higher for a mouse ECG file
versus a Human ecg. This is because the QRS is ‘sharper’ for a mouse ecg than for a Human one. Of note, NaN
should be represented by the value -32768 in the ecg (WFDB standard).

Parameters
* ecgq - electrocardiogram (mV)
» fs — sampling frequency (Hz)
* lcf —low cut-off frequency (Hz)
* hcef - high cut-off frequency (Hz)
* debug - plot output filtered signal (boolean)

* nt — frequency to cut with a Notch filter (Hz). Leave the field empty (‘[]’) if you do not
want the Notch filter to be applied.

Returns
* bpfecg: band pass filtered ecg signal

Example: preprocess an ecg recording from the mitdb (physionet.com) by applying a bandpass filter (0.5-100
Hz)

download_wfdb_records ('mitdb', "105', '.'");
[~,ecg,Fs]=rdsamp ('mitdb/105"',1);

bpfecg = bpfilt(ecqg,Fs,0.5,100,[1,1);

2.4.2 bsqi ()

mhrv.ecqg.bsqi (refgrs, testqrs, agw, fs)
This algorithm can be used to estimate the signal quality of a single channel electrocardiogram®*. It compares
the agreement between the R-peak annotations (annl and ann2) made by two different R-peak detectors. If the
two detectors agree locally then the signal quality (sqi) is good and if they disagree then it is likely because of
some uderlying artifacts/noise in the signal. The limitation of this method is that when one of the two detectors
fails for whatever reason other than the presence of noise then the quality will be zero.

Parameters

! Behar, Joachim, Alistair Johnson, Gari D. Clifford, and Julien Oster. > Annals of biomedical engineering 42, no. 6 (2014): 1340-1353.

3 Behar, J., Oster, J., Li, Q., & Clifford, G. D. (2013). ECG signal quality during arrhythmia and its application to false alarm reduction. IEEE
transactions on biomedical engineering, 60(6), 1660-1666.

4 Johnson, Alistair EW, Joachim Behar, Fernando Andreotti, Gari D. Clifford, and Julien Oster. “Multimodal heart beat detection using signal
quality indices.” Physiological measurement 36, no. 8 (2015): 1665.
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» refqrs — vector of QRS annotations from a first peak detector (in seconds)
* testgrs — vector of QRS annotations from a secon peak detector (in seconds)
* agw — agreement window (sec)
» fs —sampling frequency (Hz)
Returns
* FI1: signal quality measure (nu)
* IndMatch: indices of matching peaks (nu)
» meanDist: mean distance between matching refqrs and testqrs peaks (sec)

Example: Comparing ggrs to wjgrs on a record from mitdb.

download_wfdb_records ('mitdb', '105', '.");

[tm, ecg,Fs]=rdsamp ('mitdb/105",1, 'from',450000, "to',480000) ;

bpfecg = bpfilt (ecqg,Fs,5,45,11,0); ¢ prefilter in range [5 — 45] Hz

anns_jqgrs = wjqgrs (bpfecg,Fs,0.3,0.250,10); % wjgrs peak detector

anns_ggrs = gqrs('mitdb/105', 'from',450000, 'to',480000); ¢ ggrs peak detector
anns_gqgrs = double (anns_ggrs) ;

[F1,~] = bsgi( anns_jgrs', anns_gqrs,0.050,Fs);

plot (tm, ecqg);

hold on; plot (tm(anns_jgrs),ecg(anns_jgrs), '+r');

hold on; plot(tm(anns_gqgrs),ecg(anns_gqgqrs), 'tk');
legend(['ecg with quality ' num2str(Fl)], 'wjgrs', 'ggrs');

2.4.3 ecgsqi ()

mhrv.ecqg.eecgsqi (annl, ann2, ecg, fs, varargin)

Computes bsgi** to estimate the signal quality of an ECG signal. The bsqi index is computed over the whole
ecg recording with a granularity specified by the user.

Parameters
* annl — vector of QRS annotations from a first peak detector (sample)
* ann2 - vector of QRS annotations from a secon peak detector (sample)
* ecg — electrocardiogram time series (mV)
» fs —sampling frequency of the ecg (Hz)
* varargin — pass in name-value pairs to configure advanced options:

— agw: agreement window tolerated between annotations from the two peak detectors in
order for the two annotations to be considered in agreement (in seconds)

— sw: the size of the window on which the signal quality is computed (in seconds). Default
is 5 sec.

— rw: granularity at which the sqi is computed (in seconds). By default the sqi is computed
at every second.

— mw: window for a post-processing median smoothing (in number of samples). By default
there is no median post-processing.

— thrsqi: final sqi threshold. The signal will be considered of good quality for all sqi value
above this threshold (output sqi will be one for these). Conversely the signal will be
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considered of bad quality for all sqi value below this threshold (output sqi will be zero for
these).

— plot: true/false whether to generate a plot. Defaults to true if no output arguments were
specified.

Returns
* sqi: signal quality time series (nu, in range 0-1)
* tsqi: time vector for the sqi vector (sec)

Example: an ecg sample from the mitdb (physionet.org) is downloaded, preprocessed and two peak detectors
are ran (wjqrs and gqrs). The two sets of R-peak annotations are used to compare the signal quality using the
ecgsqi function.

download_wfdb_records ('mitdb', '105', '".");

recordName = 'mitdb/105'";

[~,ecg,Fs]=rdsamp (recordName, 1) ;

bpfecg = bpfilt(ecqg,Fs,5,45,11,0); % prefilter in range [5 — 45] Hz
anns_jqrs = wjqgrs (bpfecqg,Fs,0.3,0.250,10); % wjgrs peak detector

anns_gqgrs = gqgrs (recordName); % ggrs peak detector
anns_gqgrs = double (anns_gqgrs) ;
[ sgi, tsgi ] = ecgsgi( anns_jgrs', anns_gqgrs, ecg, Fs, 'plot', true, 'mw', 1, 'sw

-', 5, 'rw', 1, 'agw', 0.050);

24.4 jqgrs()

mhrv.ecqg.jqrs (ecg, fs, thr, rp, debug)
Implementation of an energy based qrs detector'. The algorithm is an adaptation of the popular Pan & Tompkins
algorithm”. The function assumes the input ecg is already pre-filtered i.e. bandpass filtered and that the power-
line interference was removed. Of note, NaN should be represented by the value -32768 in the ecg (WFDB

standard).

Parameters
* ecg — vector of ecg signal amplitude (mV)
» fs — sampling frequency (Hz)
¢ thr — threshold (nu)
* rp - refractory period (sec)
* debug - plot results (boolean)

Returns

* grs_pos: position of the qrs (sample)

Example: process an ecg recording from the mitdb (physionet.org). A bandpass filter is used to preprocess the
ECG in the range [4 - 45]Hz. Then the peak detector is ran with a refractory period of 250 ms (a standard value
for Human ECG analysis) is specified.

download_wfdb_records ('mitdb', '105', '.");
[~,ecg,Fs]=rdsamp ('mitdb/105",1);

bpfecg = bpfilt(ecqg,Fs,4,45,1[]1,0); ¢ prefilter in range [4-45] Hz

(continues on next page)

2 Pan, Jiapu, and Willis J. Tompkins. ** IEEE Trans. Biomed. Eng 32.3 (1985): 230-236.
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(continued from previous page)

grs_pos = jgrs (bpfecqg,Fs,0.4,0.250,1); ¢ peak detection and plot

2.4.5 wjqrs()

mhrv.ecqg.wjqrs (ecg, fs, thres, rp, ws)

This function' is used to run the jqrs peak detector using a sliding (non-overlapping) window. This is usefull
in the cases where the signal contains important artefacts which could bias the jqrs threshold evaluation or if
the amplitude of the ecg is changing substantially over long recordings because of the position of the electrodes
move for example. In these instances the adaptation of the energy threshold is useful.

Parameters
* ecg —ecg signal (mV)
» fs — sampling frequency (Hz)
* thres — threshold to be used in the P&T algorithm(nu)
* rp — refractory period (sec)
¢ ws — window size (sec)
Returns
* grs: grs location in nb samples (ms)

Example: perform peak detection on an ecg recording from the mitdb (physionet.org), A refractory period of
250 ms (a standard value for Human ECG) and a threshold of 0.3 are used.

download_wfdb_records ('mitdb', '105', ".");
[~,ecg,Fs]=rdsamp ('mitdb/105"',1);

bpfecg = bpfilt (ecqg,Fs,4,45,11,0); ¢ prefilter in range [4-45] Hz

anns_jqrs = wjqgrs (bpfecqg,Fs,0.3,0.250,10); % jgrs running on each segment of 10
—sec length

2.4.6 grs_adjust ()

mhrv.ecqg.qrs_adjust (ecg, grs, fs, inputsign, tol, debug)

This function' is used to adjust the qrs location by looking for a local min or max around the input qrs points.
For example, this is useful when parts of the grs are located on a positive part of the R-wave and parts on a
negative part of the R-wave in order to make them all positive or negative - this can be useful for heart rate
variability analysis. It is also useful for template substraction in the context of non-invasive fetal ECG source
separation in order to ensure the maternal template is well aligned with each beat.

Parameters
* ecg - vector of ecg signal amplitude (mV)
* grs — peak position (sample number)
* fs —sampling frequency (Hz)
* inputsign - sign of the peak to look for (-1 for negative and 1 for positive)
e tol - tolerance window (sec)

* debug - (boolean)
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Returns
* cqrs: adjusted (corrected) qrs positions (sample number)

Example:

download_wfdb_records ('mitdb', '105', '".");
[~,ecg,Fs]=rdsamp ('mitdb/105",1);
bpfecg = bpfilt (ecqg,Fs,4,45,[1,0) % prefilter in range [4-45] Hz

anns_jqrs = wjqgrs (bpfecqg,Fs,0.3,0.250,10); % jgrs running on each segment of 10
—sec length

’

cqgrs = grs_adjust (ecg, anns_jqgrs,Fs,-1,0.050,1);

2.5 mhrv.hrv

2.5.1 hrv_time ()
mhrv.hrv.hrv_time (nni, varargin)
Calculates time-domain HRV mertics from NN intervals.
Parameters
e nni — Vector of NN-interval dirations (in seconds)
* varargin — Pass in name-value pairs to configure advanced options:

— pnn_thresh_ms: Optional. Threshold NN interval time difference in milliseconds (for the
pNNx HRV measure).

— plot: true/false whether to generate a plot. Defaults to true if no output arguments were
specified.

Returns
Table containing the following HRV metrics:
* AVNN: Average NN interval duration.
* SDNN: Standard deviation of NN interval durations.
* RMSSD: Square root of mean summed squares of NN interval differences.

* pNNx: The percentage of NN intervals which differ by at least x (ms) (default 50) from their
preceding interval. The value of x in milliseconds can be set with the optional parameter
‘pnn_thresh_ms’.

» SEM: Standard error of the mean NN interval length.

2.5.2 hrv_freq()

mhrv.hrv.hrv_£freq (nni, varargin)
NN interval spectrum and frequency-domain HRV metrics This function estimates the PSD (power spectral
density) of a given nn-interval sequence, and calculates the power in various frequency bands.

Parameters
* nni — RR/NN intervals, in seconds.

* varargin — Pass in name-value pairs to configure advanced options:
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— methods: A cell array of strings containing names of methods to use to estimate the
spectrum. Supported methods are:

* lomb: Lomb-scargle periodogram.

% ar: Yule-Walker autoregressive model. Data will be resampled. No windowing will
be performed for this method.

* welch: Welch’s method (overlapping windows).
* f£ft: Simple fft-based periodogram, no overlap (also known as Bartlett’s method).

In all cases, a window will be used on the samples according to the win_ func param-
eter. Data will be resampled for all methods except 1omb. Default value is { ' lomb',
'ar', 'welch'}.

— time_intervals: specify the time interval vector tnn. If it is not specified then it will be
computed from the nni time series.

— power_methods: The method(s) to use for calculating the power in each band. A cell
array where each element can be any one of the methods given in ‘methods’. This also
determines the spectrum that will be returned from this function (pxx). Default: First
value in methods.

— norm_method: A string, either total or 1f_hf. If total, then the power in each
band will be normalized by the total power in the entire frequency spectrum. If 1f_hf,
then only for the LF and HF bands, the normalization will be performed by the (LF+HF)
power. This is the standard method used in many papers to normalize these bands. In any
case, VLF and user-defined custom bands are not affected by this parameter.

— band_factor: A factor that will be applied to the frequency bands. Useful for shifting
them linearly to adapt to non-human data. Default: 1.0 (no shift).

— vIf_band: 2-element vector of frequencies in Hz defining the VLF band. Default: [0.003,
0.04].

— If_band: 2-element vector of frequencies in Hz defining the LF band. Default: [0.04,
0.15].

— hf_band: 2-element vector of frequencies in Hz defining the HF band. Default: [0.15,
0.4].

— extra_bands: A cell array of frequency pairs, for example { [f_start, f_end],
. }. Each pair defines a custom band for which the power and normalized power will be
calculated.

— window_minutes: Split intervals into windows of this length, calcualte the spectrum in
each window, and average them. A window funciton will be also be applied to each win-
dow after breaking the intervals into windows. Set to [] if you want to disable windowing.
Default: 5 minutes.

— detrend_order: Order of polynomial to fit to the data for detrending. Default: 1 (i.e. linear
detrending).

— ar_order: Order of the autoregressive model to use if ar method is specific. Default: 24.

— welch_overlap: Percentage of overlap between windows when using Welch’s method.
Default: 50 percent.

— win_func: The window function to apply to each segment. Should be a function that
accepts one parameter (length in samples) and returns a window of that length. Default:
@hamming.
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— plot: true/false whether to generate plots. Defaults to true if no output arguments were
specified.

Returns

* hrv_fd: Table containing the following HRV metrics:
TOTAL_POWER: Total power in all three bands combined.
VLF_POWER: Power in the VLF band.
LF_POWER: Power in the LF band.
HF_POWER: Power in the HF band.
VLF_NORM: 100 * Ratio between VLF power and total power.

LF_NORM: 100 * Ratio between LF power and total power or the sum of LF and HF
power (see ‘norm_method’). - HF_NORM: 100 * Ratio between HF power and total
power or the sum of LF and HF power (see norm_method).

LF_TO_HF: Ratio between LF and HF power.

LF_PEAK: Frequency of highest peak in the LF band.
HF_PEAK: Frequency of highest peak in the HF band.

BETA: Slope of log-log frequency plot in the VLF band.

Note that each of the above metrics will be calculated for each value given in
power_methods, and their names will be suffixed with the method name (e.g.
LF_PEAK_LOMB).

* pxx: Power spectrum. It’s type is determined by the first value in power_methods.

» f_axis: Frequencies, in Hz, at which pxx was calculated.

2.5.3 hrv_nonlinear ()

mhrv.hrv.hrv_nonlinear (nni, varargin)
Calcualtes non-linear HRV metrics based on Poincaré plots, detrended fluctuation analysis (DFA)” and Multi-
scale Entropy (MSE)°.

Parameters
e nni — RR/NN intervals, in seconds.
* varargin — Pass in name-value pairs to configure advanced options:

— mse_max_scale: Maximal scale value that the MSE will be calculated up to.

mse_metrics: Whether to output MSE at each scale as a separate metric.

sampen_r: r value used to calculate Sample Entropy

sampen_m: m value used to calculate Sample Entropy

plot: true/false whether to generate plots. Defaults to true if no output arguments were
specified.

Returns

2 Peng, C.-K., Hausdorff, J. M. and Goldberger, A. L. (2000) ‘Fractal mechanisms in neuronal control: human heartbeat and gait dynamics in
health and disease, Self-organized biological dynamics and nonlinear control.” Cambridge: Cambridge University Press.

3 Costa, M. D., Goldberger, A. L. and Peng, C.-K. (2005) ‘Multiscale entropy analysis of biological signals’, Physical Review E - Statistical,
Nonlinear, and Soft Matter Physics, 71(2), pp. 1-18.
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* hrv_nl: Table containing the following HRV metrics:

— SD1: Poincare plot SD1 descriptor (std. dev. of intervals along the line perpendicular to
the line of identity).

SD2: Poincare plot SD2 descriptor (std. dev. of intervals along the line of identity).

alphal: Log-log slope of DFA in the low-scale region.

alpha2: Log-log slope of DFA in the high-scale region.

SampEn: The sample entropy.

2.5.4 hrv_fragmentation/()
mhrv.hrv.hrv_fragmentation (nni, varargin)
Computes HRV fragmentation indices' of a NN interval time series.
Parameters nni — Vector of NN-interval dirations (in seconds)
Returns
Table containing the following fragmentation metrics:
* PIP: Percentage of inflection points.
» TALS: Inverse average length of segments.
» PSS: Percentage of NN intervals that are in short segments.

* PAS: Percentage of NN intervals that are in alternation segments of at least 4 intervals.

2.6 mhrv.rri

2.6.1 ansrr()

mhrv.rri.ansrr (17, freqs, varargin)
Add Noised Sines to RR interval time series. This function generates a signal of sines embedded in gaussian
white noise and adds it to an RR interval time series.

Parameters
* rri — RR-intervals values in seconds.
» freqgs — Vector containing desired sine frequencies, in Hz.
* varargin — Pass in name-value pairs to configure advanced options:

— var_r: Desired variance of the RR intervals. Can be used the scale the intervals before
adding the noised sines. Leave empty to forgo scaling.

— mix: Mixture ratio between the given RR intervals and the generated sines. Default: 0.5
i.e. sines will have alf the variance of the RR intervals (after scaling).

— snr: Signal to Noise ratio of the white gaussian noise that will be added to the sines.
Default: 2.

Returns

I Costa, M. D., Davis, R. B, & Goldberger, A. L. (2017). Heart Rate Fragmentation: A New Approach to the Analysis of Cardiac Interbeat
Interval Dynamics. Frontiers in Physiology, 8(May), 1-13.
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* rri_out: RR intervals after adding noised sines.

2.6.2 detrendrr ()

mhrv.rri.detrendrr (rri, lambda, Fs, varargin)
A detrending method* for the RR intervals. This is used when analysing RR interval time series over a long
window thus where the stationarity assumption is not valid anymore. Of note: a number of HRV methods such
as the fragmentation measures and the DFA measures do not assume the intervals to be stationary. Thus usage
of this detrending tool is specific to what HRV measures are being studied. Detrending will also likely affect the
low frequency fluctuation information contained in the VLF band.

Parameters
e rri — Vector of RR-interval dirations (seconds)
¢ lambda — lambda (lambda=10 for Human)
* F's — the sampling frequency of the original ECG signal (Hz)
* varargin — Pass in name-value pairs to configure advanced options:

— plot: true/false whether to generate a plot. Defaults to true if no output arguments were
specified (boolean).

Returns
e rri_detrended: detrended rri interval (seconds)

Example: process an ecg recording sampled at 1000 Hz and specifying a refractory period of 250 ms (a standard
value for Human ECG) and with a threshold of 0.5.

recordName = 'mitdb/105'";
[ecg, fs,~] = rdsamp (recordName, 1) ;
bpfecg = bpfilt (ecqg,fs,5,45,1]1,0); ¢ prefilter in range [5-45] Hz

anns_jqgrs = wjqgrs (bpfecqg, £fs,0.3,0.250,10); % jgrs running on each segment of 10
—sec length

z = diff (anns_Jjqgrs)/fs; ¢ get the RR intervals

nni_detrend = detrend_nn(z',10,'Fs',Fs ,'plot',true); % detrend and plot

2.6.3 dfa()
mhrv.rri.dfa (4, sig, varargin)
Detrended fluctuation analysis, DFA'. Calculates the DFA of a signal and it’s scaling exponents a; and .
Parameters
* t —time (or x values of signal)
* sig - signal data (or y values of signal)
* varargin — Pass in name-value pairs to configure advanced options:
— n_min: Minimal DFA block-size (default 4)
— n_max: Maximal DFA block-size (default 64)

4 Tarvainen, Mika P., Perttu O. Ranta-Aho, and Pasi A. Karjalainen. “An advanced detrending method with application to HRV analysis.” IEEE
Transactions on Biomedical Engineering 49.2 (2002): 172-175.

! Peng, C.-K., Hausdorff, J. M. and Goldberger, A. L. (2000) ‘Fractal mechanisms in neuronal control: human heartbeat and gait dynamics in
health and disease, Self-organized biological dynamics and nonlinear control.” Cambridge: Cambridge University Press.

2.6. mhrv.rri 47



PhysioZoo Documentation

— n_incr: Increment value for n (default 2). Can also be less than 1, in which case we
interpret it as the ratio of a geometric series on box sizes (n). This should produce box
size values identical to the PhysioNet DFA implmentation.

— alphal_range: Range of block size values to use for calculating the «; scaling exponent.
Default: [4, 15].

— alpha2_range: Range of block size values to use for calculating the ao scaling exponent.
Default: [16, 64].

Returns
* n: block sizes (x-axis of DFA)
* fn: DFA value for each block size n
* alphal: Exponential scaling factor

* alpha2: Exponential scaling factor

2.6.4 filtrr()

mhrv.rri.£filtrr (rri, trr, varargin)
Calculate an NN-interval time series (filtered RR intervals). Performs outlier detection and removal on RR
interval data. This function can perform three types of different outlier detection, based on user input: Range
based detection, moving-average filter-based detection and quotient filter based detection.

Parameters
* rri — RR-intervals values in seconds.
* trr — RR-interval times in seconds.
* varargin — Pass in name-value pairs to configure advanced options:

— filter_range: true/false whether to use range filtering (remove intervals smaller or larger
than ‘rr_min’ and ‘rr_max’).

— filter_ma: true/false whether to use a moving-average filter to detect potential outliers in
the rr-intervals. If an interval is greater (abs) than ‘win_percent’ percent of the average in
a window of size ‘win_samples’ around it, excludes the interval.

— filter_quotient: true/false whether to use the quotient filter. This fliter checks the quotient
between an interval and it’s predecessor and successors, and only allows a configured
change percentage (‘rr_max_change’) between them.

— win_samples: Number of samples in the filter window on each side of the current sample
(total window size will be 2*win_samples+1). Default: 10.

— win_percent: The percentage above/below the average to use for filtering. Default: 20.

— rr_min: Min physiological RR interval, in seconds. Intervals shorter than this will be
removed prior to poincare plotting. Default: 0.32 sec.

— rr_max: Max physiological RR interval, in seconds. Intervals longer than this will be
removed prior to poincare plotting. Default: 1.5 sec.

— rr_max_change: Maximal change, in percent, allowed between adjacent RR intervals.
Intervals violating this will be removed prior to poincare plotting. Default: 25.

— plot: true/false whether to generate a plot. Defaults to true if no output arguments were
specified.

Returns
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* nni: NN-intervals (RR intervals after removing outliers) values in seconds

¢ tnn: NN-interval times in seconds

2.6.5 freqfiltrr ()

mhrv.rri.freqfiltrr (rri, fc, varargin)
Performs frequency-band filtering of RR intervals. This function can apply a low-pass or high-pass filter to an
RR interval time series.

Parameters
* rri — RR-intervals values in seconds.
» fc - Filter cutoff frequency, in Hz.
* varargin — Pass in name-value pairs to configure advanced options:

resamp_freq: Frequency to resample the RR-intervals at before filtering. Must be at least
twich the maximal frequency in the signal. Default: 5 Hz.

forder: Order (length in samples) of the filter to use. Default: 100.

ftype: A string, either ‘low’ or ‘high’, specifying the type of filter to apply.

plot: true/false whether to generate a plot. Defaults to true if no output arguments were
specified.

Returns
* rri_out: RR intervals after filtering.

e trr_out: Times of filtered RR intervals, in seconds.

2.6.6 mse ()

mhrv.rri.mse (sig, varargin)
Calculates the Multiscale Entropy’, MSE, of a signal, a measure of the signals complexity. The algorithms
calculates the Sample Entropy of the signal at various ‘scales’ from 1 to max_scale. At each scale, the signal is
downsampled by averaging ‘scale’ samples and the Sample Entropy is calculated for the downsampled signal.

Parameters
» sig - Signal to calculate MSE for.
* varargin — Pass in name-value pairs to configure advanced options:
— mse_max_scale: Maximal scale to calculate up to. Default: 20.

— sampen_r: Value of ‘r’ parameter to use when calculating sample entropy (max distance
between two points that’s considered a match). Default: 0.2.

— sampen_m: Value of ‘m’ parameter to use when calculating sample entropy (length of
templates to match). Default: 2.

— normalize_std: Whether or not to normalize the signal to std=1 before calculating the
MSE. This affects the meaning of r.

— plot: true/false whether to generate a plot. Defaults to true if no output arguments were
specified.

2 Costa, M. D., Goldberger, A. L. and Peng, C.-K. (2005) ‘Multiscale entropy analysis of biological signals’, Physical Review E - Statistical,
Nonlinear, and Soft Matter Physics, 71(2), pp. 1-18.
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Returns
* mse_result: The sample entropy value at each scale.

* scale_axis: The corresponding scale values that were used.

2.6.7 poincare ()
mhrv.rri.poincare (rri, varargin)
Calculates HRV metrics from a Poincaré plot of the input data.
Parameters
* rri — Row vector of RR-interval lengths in seconds.
* varargin — Pass in name-value pairs to configure advanced options:

— sdl_factor: Factor to multiply the standard devation along the perpendicular line (SD1)
to get the radius of the ellipse along that axis. Default is 2 (so over 95% of points will be
inside the ellipse).

— sd2_factor: As above, but for the standard deviation along the line of identity (SD2).
Default: 3.

— plot: true/false whether to generate a plot. Defaults to true if no output arguments were
specified.

Returns
* sdl: Standard deviation of RR intervals along the axis perpendicular to the line of identity.

* sd2: Standard deviation of RR intervals along the line of identity.

2.6.8 sample_entropy ()
mhrv.rri. sample_entrogy (sig, m, r)
Calculate sample entropy” (SampEn) of a signal. Sample entropy is a measure of the irregularity of a signal.
Parameters
* sig - The input signal.
* m— Template length in samples.
* r — Threshold for matching sample values.

Returns The sample entropy value of the input signal.

2.7 mhrv.wfdb

2.7.1 download wfdb ()

mhrv.wfdb.download wfdb (dest_base_dir)
Downloads the WFDB binaries for this OS. This function detects the current OS and attempts to download the
approprate WFDB binaries. By default they will be downloaded into the folder ‘bin/wfdb’ under the current

MATLAB directory.

3 Richman, J. S., & Moorman, J. R. (2000). ‘Physiological time-series analysis using approximate entropy and sample entropy.” American
Journal of Physiology. Heart and Circulatory Physiology, 278(6), H2039?H2049.
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Parameters dest_base_dir — Optional. Directory to download into. Will be created if it doesn’t
exist. A folder name ‘wfdb’ will be created inside. If this is not provided, defaults to the folder
‘bin/’ under the current MATLAB directory.

Returns

* bin_path: Path the the directory containing the WFDB binaries that were downloaded.

2.7.2 download_wfdb_records ()
mhrv.wfdb.download_wfdb_records (db_name, rec_names, outdir, varargin)
Downloads records from the PhysioBank database on PhysioNet.
Parameters
* db_name — Name of database on physiobank, e.g. mitdb.

* rec_names — A string or cell of strings containing a regex pattern to match against the
record names from the specified database. Matching will be performed against the entire
record name (as if regex is delimited by ~$). Empty array or string will match all records.
See examples below.

* outdir — The root directory to download to. A folder with the specified db_name will be
created within it.

* varargin — Pass in name-value pairs to configure advanced options:
— base_url: Specify an alternative physiobank URL to download from.
Returns
e dl_recs: Names of downloaded records.
¢ dl_ann: Names of annotators for downloaded records.
e dl_files: Paths to all downloaded files.
Examples:

1. Download single record, mitdb /100 to folder db/mitdb:

’download_wfdb_records('mitdb', '100', 'db');

2. Download three specific records from mitdb:

’download_wfdb_records('mitdb', {r100','200"','222"}, 'db');

3. Download all records starting with ‘1’ (e.g. 100, 101, 122...) from mitdb:

’download_wfdb_records('mitdb', 'I\d+', 'db');

4. Download records ‘123, ‘124’ and any record ending with 0 from mitdb:

’download_wfdb_records(‘mitdb', {'"12[3,4]1"', '\d+0'}, 'db'");

5. Download all records from mitdb:

’download_wfdb_records(‘mitdb', [1, 'db'");

2.7. mhrv.wfdb
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2.7.3 ecgrr()

mhrv.wfdb.ecgrr (rec_name, varargin)
Calculate an RR-interval time series from PhysioNet ECG data. Detects QRS in a given sigal and calculates the
RR intervals.

Parameters

* rec_name — Path and name of a wfdb record’s files e.g. db/mitdb/100 if the record files
(both 100.dat and 100.hea) are in a folder named ‘db/mitdb’ relative to MATLABs pwd.

* varargin — Pass in name-value pairs to configure advanced options:

— ann_ext: Specify an annotation file extention to use instead of loading the record itself
(.dat file). If provided, RR intervals will be loaded from the annotation file instead of
from the ECG. Default: empty (don’t use annotation).

ecg_channel: Number of ecg signal in the record (default [], i.e. auto-detect signal).

from: Number of first sample to start detecting from (default 1)

to: Number of last sample to detect until (default [], i.e. end of signal)

plot: true/false whether to generate a plot. Defaults to true if no output arguments were
specified.

Returns
¢ rri: RR-intervals values in seconds.

 trr: RR-interval times in seconds.

2.7.4 get_signal_channel ()

mhrv.wfdb.get_signal_channel (rec_name, varargin)
Find the channel of a signal in the record matching a description. By default, if no description is specified it
looks for ECG signal channels.

Parameters

* rec_name — Path and name of a wfdb record’s files e.g. db/mitdb/100 if the record files
(both 100.dat and 100.hea) are in a folder named ‘db/mitdb’ relative to MATLABs pwd.

* varargin — Pass in name-value pairs to configure advanced options:

— sig_regex: A regular expression that should match the desired signal’s description in the
header file.

— comment_regex: A regular expression that matches the comment format in the header
file.

Returns

* chan: Number of the first channel in the signal that matches the description regex, or an
empty array if no signals match.

* Fs: Sampling frequency

* N: Number of samples
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2.7.5 get_wfdb_tool_path()

mhrv.wfdb.get_wfdb_tool_path (fool_name, base_search_path)
Returns the path to a wfdb tool, takes OS into account Looks for the given tool recursively under the current
MATLAB directory (or a given directory), and then recursively under the folders in the SPATH environment
variable. In case the tool is found, the containing directory path will be persisted to speed up the next search.

Parameters

* tool_name - A string containg the name of the wfdb tool, e.g. ‘gqrs’, ‘wfdb-config’,
‘rdsamp’ etc. Should not include a file extension.

* base_search_path — Optional. An absolute path to use as a base for searching for the
tool. If not provided defaults to pwd().

Returns

* tool_path - The path of the wfdb tool, including it’s os-specific file extension (e.g. .exe). In
case the tool wasn’t found, an error will be raised.

2.7.6 ggrs ()

mhrv.wfdb.gqrs (rec_name, varargin)
Wrapper for WFDB’s ‘gqrs’ and ‘gqpost’ tools. Finds the onset of QRS complexes in ECG signals given in
PhysioNet format and returns them as a MATLAB vector.

Parameters

* rec_name — Path and name of a wfdb record’s files e.g. db/mitdb/100 if the record files
(both 100.dat and 100.hea) are in a folder named ‘db/mitdb’ relative to MATLABs pwd.

* varargin — Pass in name-value pairs to configure advanced options:
— ecg_channel: Number of ecg signal in the record (default [], i.e. auto-detect signal).

— gqconf: Filename or Path to a gqrs config file to use. This allows adapting the algorithm
for different signal and/or animal types (default is ’, i.e. no config file). Note that if only
a filename is provided, ‘gqrs’ will attempt to find the gqconf file on the MATLAB path.

— gqpost: Whether to run the ‘gqpost’ tool to find erroneous detections (default false).
— from: Number of first sample to start detecting from (default 1)
— to: Number of last sample to detect until (default [], i.e. end of signal)
Returns
* grs: Vector of sample numbers where the an onset of a QRS complex was found.

* outliers: Vector of sample numbers which were marked by gqpost as suspected false detec-
tions.

Note: If no output variables are given to the function call, the detected ECG signal and QRS complexes will be
plotted in a new figure.

2.7.7 isrecord()

mhrv.wfdb.isrecord (rec_name, data_ext)
Checks if the given WFDB record name exists locally.
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Parameters

* rec_name — Path and name of a wfdb record’s files e.g. ‘db/mitdb/100’. Can be an abso-
lute or relative path (relative to the MATLAB pwd).

* data_ext — Optional. The extension of the data file to look for. Defaults to ‘dat’ if not
specfied.

Returns

* isrecord: True if the given record path is valid, otherwise false. Valid means that e.g. both the
files db/mitdb/100.dat (or another extension as specified in ‘data_ext’) and db/mitdb/100.hea
exist if rec_name was ‘db/mitdb/100’).

2.7.8 grs_compare ()

mhrv.wfdb.qrs_compare (rec_name, varargin)
Compare R-peak detection algorithm to annotations. qrs_compare can run a r-peak detector on a given phy-
sionet record and compare the detections to an annotation file. The function assumes that the annotation file
has the same record name, with a user-configurable file extension. The function supports both wfdb format
and matlab’s ‘mat’ format for the annotation files. The comparison of the detected QRS locations to the refer-
ence annotations is performed by calculating a joint-accuracy measure (F1), based on the Sensitivity (SE) and
Positive-predictivity (PPV) of the test detector’s annotations'.

Parameters

* rec_name — Path and name of a wfdb record’s files e.g. db/mitdb/100 if the record files
(both 100.dat and 100.hea) are in a folder named ‘db/mitdb’ relative to MATLABs pwd.

* varargin — Pass in name-value pairs to configure advanced options:

— tolerance: Threshold tolerance time, in seconds, for two peak detections to be considered
equal.

— ann_ext: Extension of annotation file.
— ann_format: Format of annotation file. Can be wfdb or mat.

— ecg_channel: Channel number of ecg signal in the record (default [], i.e. auto-detect
signal).

— qrs_detector: Name of qgrs detector to use. Can be rgrs or ggrs.

— plot: true/false whether to generate a plot. Defaults to true if no output arguments were
specified.

Returns

* sqi: Signal quality indices for the comparison between the detector and annotations.

2.7.9 grs_compare_set ()
mhrv.wfdb.qrs_compare_set (set_dir, ann_ext, varargin)
Compares reference QRS detections to test detections on a set of wfdb records.
Parameters
* set_dir — directory path containing the wfdb files and annotations

¢ ann_ext — file extension of the annotation files.

! Johnson, A. E. W., Behar, J., et al. (2015). Multimodal heart beat detection using signal quality indices. Physiological Measurement, 36, 1-15.
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* varargin — Pass in name-value pairs to configure advanced options:
— any parameter supported by qrs_compare() can be passed to this function.

— plot: true/false whether to generate a plot. Defaults to true if no output arguments were
specified.

Returns
* sqis: A table containing quality indices for each of the input files.

* stats: A table containing the Mean and Gross values for the quality indices over all files.

2.7.10 rdann()

mhrv.wfdb.rdann (rec_name, ann_ext, varargin)
Wrapper for WFDB’s ‘rdann’ tool. Reads annotation files in PhysioNet format and returns them as a MATLAB
vector.

Parameters

* rec_name — Path and name of a wfdb record’s files e.g. db/mitdb/100 if the record files
(both 100.dat and 100.hea) are in a folder named ‘db/mitdb’ relative to MATLABs pwd.

* ann_ext — Extension of annotation file. E.g. wuse ‘qrs’ is the annotation file is
mitdb/100.qrs.

* varargin — Pass in name-value pairs to configure advanced options:

ann_types’: A double-quoted string of PhysioNet annotation types that should be read,
e.g. % to read both annotations of type ‘N’ and type ‘. Default is empty, i.e. return
annotations of any type.

from: Number of first sample to start detecting from (default 1)

to: Number of last sample to detect until (default [], i.e. end of signal)

plot: Whether to plot the all the channels and annotations in the file. Useful for debugging.
Returns
» ann: A NxI vector with the sample numbers that have annotations.

* ann_types: A NxI cell array with annotation types (strings, see PhysioNet documentation).

2.7.11 rdsamp ()

mhrv.wfdb.rdsamp (rec_name, varargin)
Wrapper for WFDB’s ‘rdsamp’ tool. Reads channels in PhysioNet data files and returns them in a MATLAB

matrix.
Parameters

* rec_name — Path and name of a wfdb record’s files e.g. db/mitdb/100 if the record files
(both 100.dat and 100.hea) are in a folder named ‘db/mitdb’ relative to MATLABs pwd.

* varargin — Pass in name-value pairs to configure advanced options:

— chan_list: A list of channel numbers (starting from 1) to read from the record, e.g. to read
the first three channels use [1, 2, 3]. Default is [], i.e. read all channels from the record.

— from: Number of first sample to start detecting from (default 1)
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— to: Number of last sample to detect until (default [], i.e. end of signal)
Returns
* t: A vector with the sample times in seconds.
* sig: A matrix where is column is a different channel from the signal.

* Fs: The sampling frequency of the data.

2.712 rqrs()

mhrv.wfdb.rqrs (rec_name, varargin)
R-peak detection in ECG signals, based on ggrs and ggpost. rqgrs Finds R-peaks in PhysioNet-format
ECG records. It uses the ggrs and ggpost programs from the PhysioNet WFDB toolbox, to find the QRS
complexes. Then, it searches forward in a small window to find the R-peak.

Parameters

* rec_name — Path and name of a wfdb record’s files e.g. db/mitdb/100 if the record files
(both 100.dat and 100.hea) are in a folder named ‘db/mitdb’ relative to MATLABs pwd.

* varargin — Pass in name-value pairs to configure advanced options:
— ecg_channel: Number of ecg signal in the record (default [], i.e. auto-detect signal).

— gqconf: Path to a gqrs config file to use. This allows adapting the algorithm for different
signal and/or animal types (default is ’, i.e. no config file).

— ggpost: Whether to run the ‘ggpost’ tool to find and remove possibly erroneous detections.
— from: Number of first sample to start detecting from (default 1)

— to: Number of last sample to detect until (default [], i.e. end of signal)

— window_size_sec: Size of the forward-search window, in seconds.

— plot: true/false whether to generate a plot. Defaults to true if no output arguments were
specified.

Returns
* grs: Vector of sample numbers where the an onset of a QRS complex was found.
* tm: Time vector (x-axis) of the input signal.
* sig: The input signal values.

* Fs: The input signals sampling frequency.

2.7.13 wfdb_header ()
mhrv.wfdb.wfdb_header (rec_name)
Returns metadata about a WFDB record based on it’s header file.

Parameters rec_name — Path and name of a wfdb record’s files e.g. db/mitdb/100 if the record
files (both 100.dat and 100.hea) are in a folder named ‘db/mitdb’ relative to MATLABs pwd.

Returns
A struct with the following fields:

e rec_name: The record name
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Fs: Sampling frequency

N_samples: Number of samples

N_channels: Number of channels (different signals) in the record

channel_info: A cell array of length N_channels with the metadata about each channel

duration: A struct with the fields h,m,s,ms corresponding to duration fields - hours, miutes,
seconds, milliseconds.

total_seconds: Records total duration in seconds.

Note: If no output arguments are given, prints record and channel info to console.

2.7.14 wrann()

mhrv.wfdb.wrann (rec_name, ann_ext, ann_idx, varargin)
Wrapper for WFDB’s ‘wrann’ tool. Write annotation files in PhysioNet format given a MATLAB vector.

Parameters

* rec_name — Path and name of a wfdb record’s files e.g. db/mitdb/100. If a header file for

the record doesn’t exist one will be created (but fs must be specified in varargin).

ann_ext — Extension of annotation file to write. E.g. use ‘qrs’ to write the annotation file
mitdb/100.qrs.

ann_idx — A column vector of integer type containing sample indices of the annotations.
varargin — Pass in name-value pairs to configure %advanced options:

— fs: The sampling frequency of the signal which is being annotated. Pass this in if writing
annotations for a record which doesn’t exist (i.e. a header file should be created).

— comments: A cell array of strings which will bea written to the header file as comments
(one per line). Will only be written when a new header file is craeted by this function.

— type: Either a single character that will be used as the type for all annotations, or a cell
array the same size ‘ann_idx’ containg a different annotation type per sample.

— sub: Either a single number (-128 ~ 128) that will be used as the subtype attribute for all
annotations, or a column vector the same size as ‘ann_idx’ containg a different subtype
per sample.

— chan: Either a single number (-128 ~ 128) that will be used as the chan attribute for all
annotations, or a column vector the same size as ‘ann_idx’ containg a different chan per
sample.

— num: Either a single number (-128 ~ 128) that will be used as the num attribute for all
annotations, or a column vector the same size as ‘ann_idx’ containg a different num per
sample.

— aux: Either a single string that will be used as the aux attribute for all annotations, or a
string cell array the same size as ‘ann_idx’ containg a different aux per sample.

Returns A cell array with the paths of files that were created.
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